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Getting started
When you open Pedigree Forge you can start entering information straight away. The program is ready for 
you to enter the first person:

The “Action Bar” runs down the left side of the Pedigree Forge’s main window giving access to various 
editing screens. The top button (person icon), allows you to enter and edit information on the currently 
selected person. The main information is added in the panel to right of the action bar. 

Clicking the same Action Bar button again will hide the editing panel; click it again will show the editing 
panel. 

Add the first person
Enter the first person’s name. When you start Pedigree Forge for the first time, forenames and surnames 
are entered separately. Advanced users familiar with other family history software might prefer to edit 
these in a single box (this can be changed in the options). 



When you move to the next field, Pedigree Forge will try and set the person’s sex automatically. It has a 
large database of names, based on traditional usage, but this isn’t infallible, you can change it if you want 
to, or set it manually if it hasn’t recognised the name. 

If you want, you can add an occupation. Pedigree Forge has a database of common occupations, and will try
and auto suggest for you.

If you want to accept the suggestion, press the [ENTER] key. If you continue typing, your own text will 
overwrite the suggestion. Pressing the [DELETE] key will stop a suggestion from showing.

Next, you can enter the date of birth. At the simplest level, dates should be entered as as “dd mmm yyyy”, 
that is the day (in numbers), a space, then the first three letters of the month’s name, then a space, then 
the year. For example:

Pedigree Forge accepts a wide variety of date formats (see later sections of guide), but this covers the 
basics. If only the year is known, that can be added by itself, for example 1809. If a date isn’t recognised, it 
will be shown in red:



You can then enter the place where the person was born. Pedigree Forge has a growing databases of places 
(currently on for the England, Scotland, Wales and Australia), which it will suggest to help you choose the 
place. It is recommended that the place information is the town or village name, followed by the county. 
The country isn’t needed, as it can be inferred from the county. You don’t have to use one of the 
suggestions, you can entered whatever you like.

Whilst we have been entering this information, Pedigree Forge has been updating the chart, which is in the 
“Charts” tab in the content section to the right of the editing panel.

The “dynamic chart” is useful whilst you are entering or editing information, but other charts of more fixed 
design can be created too.



Add a spouse
We can now add a spouse. The easiest way to do this is to click on the “<Add Spouse>” link in the editing 
panel.

You will then be asked to either create a new person, or select another person from the people already in 
the file. We are going to create a new person:

The new spouse is now the current person, and the edit panel is ready for you to enter their information:

By default, the spouse will be added as the opposite sex. Pedigree Forge fully supports same-sex 
relationships, so change the sex to the correct value if the default isn’t applicable. 



Information can be added as before. It is usual practice in genealogy to enter ladies with their maiden 
surnames. Although the sex has been automatically populated, it can be changed to allow same-sex 
relationships. In the example below, we have also added the date and place of the marriage, and the 
dynamic chart has automatically added the information too.

Add a child
We are now ready to add the children. The easiest way to do this is from the Children table of the editing 
panel. Click on the “+” button at the top of the children grid. As when adding a spouse, you will be asked if 
you want to add a new child, or select an existing person, and then the child will become the active person 
being edited. 



Navigating between people
Now that there are a few people in our database, we might need to move between them. There are various 
ways to do this, but clicking on the various links in edit panel is one of the quickest. 

Alternatively, you can click on the anyone in the dynamic chart to make them the active person:

This was a quick tour of some of the basic features of editing people in Pedigree Forge. Please refer to the 
Editing People section for more detailed information. 



Saving the project
Pedigree Forge works much the same as other desktop applications. You save the file somewhere on your 
computer. The method is the same too: select “File” from the menu bar and then “Save”. If it is the first 
time you are saving the file, then you will be prompted to select the name and location on your computer. 

By default, Pedigree Forge files have the extension “.ped”, which is short for Pedigree. 

Files can be re-opened using the “Open” item on the “File” menu; Recent files are stored in the “Recent 
Files” list, also located on the “File” menu.

Pedigree Forge offers a "Database mode" for users working with larger files—see later in the guide for more 
information.

Where to save your project
You should choose a folder on your computer where you want to save your project. For most users, this will 
be somewhere in their documents folders. It is recommended that you have a folder for each Pedigree 
Forge project, as this will help you organise files that belong with it, like source documents.  

Auto saving
Once you have saved your file for the first time, Pedigree Forge will automatically create a saved backup 
every 2 minutes. This is useful in case your computer crashes since you last saved the file manually. Note: 
the auto saved copy is only used if the program shut down unexpectedly. If you exited the program 
normally, but without saving your work, then any changes will be lost. 

Backups
By default, you will also be prompted to create a backup of your file when you exit Pedigree Forge. This is 
useful for longer term backups.



Editing People
The very basics of entering and navigating people is covered in the Getting Started section above, but 
families are complicated, and you will want to do a lot more with your family tree.

Entering facts and events
The Getting Started section covered how to enter dates and places of birth, death and marriage, but if you 
want to add more detail about these events, or add other events and facts, then this is possible too, using 
the “Facts and Events” section on the editing panel.

The facts and events table lists all facts and events that have been entered for the active person (or a couple
in which they are a spouse/partner), along with some that are generated automatically. In the example 
above, we have entered the birth and marriage, but the births of the children are automatically populated 
too.



The buttons at the top of the Fact and Events grid allow you to add or delete facts and carry out other 
common tasks. Note: more options (including other facts types) are available on the “Facts” menu bar item.
These includes a greater variety of facts. 

Clicking on one of the items in the facts and event list will show more detailed information below: 

The available fields will depend on the fact being edited. For example, a death event has the option to enter
a cause and age, but these don’t make sense for births. 



Place vs. address
The “in” field should be used for the town or village, and county. The “Address” field should be used for the 
specific address where the event took place. For example, Charles Darwin died in the village of Down, but 
the address was “Down House”: 

The address field can also be used to specify the particular church/cemetery/hospital etc, as there may be 
more than one place in the particular town or village, where the event took place.

Likelihood
The likelihood drop down box can be used to flag that a fact isn’t confirmed. It is recommended that you do 
this if you are unsure if this is the correct event. 

Facts flagged as “possibly” or “probably” are shown on charts with a question mark, and included in reports
with similar caveats.



Ages
Ages can be recorded for many types of events and facts. It is recommended that they are entered as they 
appear on the relevant source document, even if that is wrong or suspect. Ages that are whole years can be 
entered just as the number (a “y” is appended automatically to the end to indicate this is in years). 

If a more precise age was recorded, then use “m” for months “w” for weeks and “d” for days, for example 
“73y 2m” would indicate 73 years and 2 months.

Ages were often recorded on documents imprecisely, and so we want to reflect that in our record. It is 
wrong for us to assume that “infant” meant a particular age. For that reason, the follow other ages are also 
accepted:

• “full”: Often used to indicate 21 or over, but can be much older.

• “infant”: Often recorded on burials of very young children

• “child”: Often recorded in old burial records, with no further clarification

• “minor”: Usually implies under 21.

A less than “<” or greater than “>” character can also be used to imply that someone was recorded as less 
than, or greater than the given age.

If the age isn’t recognised, it will be displayed in red:

Citations
Recording where a piece of information comes from is very important. When you enter facts and events, 
you should record how you know that information is correct. 

Pedigree Forge supports two flavours of citations: full links to a source document, or a “local” citation. Both 
can be added, or deleted from the Citations list, using the “+” or trash buttons. 

The above is a citation linked to a record of Charles Darwin’s death certificate—for more information, see 
the section on “Working with sources”. The [S2] is the record identifier.



Local citations can be free-form text, although there are some templates to help you create these, and more
information can be found in the “Working with sources” section. 

Fact and event subtypes
Some facts allow you to choose a subtype, which help clarify the situation surround the fact or event.

For example, the death fact has the following subtypes: 

Marriage facts have subtypes such as: “civil partnership” “common law” and “clandestine”; Birth facts have 
a subtype “stillborn”.

Time
Some fact types, in particular, birth and death, have a time field, as these might be recorded on old 
documents—times of births are often recorded for multiple births, and times of death are recorded on 
Scottish Statutory Register death records. These are free form fields, so you can enter the information as 
you wish.

Cause
Cause of death is often written on documents, and can be recorded on death facts. Pedigree Forge will 
suggest some common causes as you type. To get the most from the reporting functions of Pedigree Forge 
(narrative reports), it is recommended that you choose something that sounds reasonable when prefixed 
with “of” for example “bronchitis”, reads nicely as “of bronchitis”, but “heart attack” would sound better if 
written as “a heart attack”, so the narrative would read: “of a heart attack”.



Notes
Notes can be entered for certain kinds of facts. They are used the narrative reports, so you may want to 
experiment with how you enter the information to get the best results if using narrative reports. 

Person or couple facts and events
Some facts pertain to a person, for example, birth, baptism and death. Whereas others, for example 
marriage, relate to a couple. This is why there are options to add either person or couple facts. If the active 
person had more than one partner or spouse, then care must be taken that the correct partner is the active 
partner before adding fact them. Please see the section on multiple spouses and partners for more 
information.

Different facts and events
The available facts cover a wide range of the options available to you, and if possible, you should record the 
information one of the standard fact types—this allows Pedigree Forge to understand what the data means.
The following facts/events are available (some are only available from the “Facts” menu:

Individual: Birth, Baptism, Census, Death, Burial, Cremation, Will, Codicil, Probate, Administration, Seat, 
Floruit, Adoption, Education, Graduation, Ordination, Emigration, Immigration, Barmitzvah,  Confirmation, 
Residence, First Communion, Naturalisation, Retirement, Blessing.

Couple: Marriage, Marriage Licence, Marriage Banns, Divorce, Engagement, Annulment, Divorce Filled.

Sometimes, although perhaps not quite obvious, a fact of a more generic kind, can represent a more 
specific kind (see the section of further type information above). For example, a marriage has a sub-type of 
a civil partnership. 

Most of the types should be obvious. The following is guidance on particular types:



Seat Fact

On old documents, a particular person might sometime be described as being “of X”; this is often their 
“main” or long term residence. The seat fact allows you to enter this information, which will then be used in
charts and reports.

Flourit
On family trees that extend back a long way, it isn’t uncommon to find a “flourit” date (often abbreviated as
fl. on charts). This is when approximate dates of birth aren’t known, but reflect the period in which the 
person was known to be alive. The date is often a range, that is between two dates. 

Custom Facts and Events

If none of the predefined facts or events meet the information you want to record, then you can add a 
custom fact, either to an individual, or two a couple. 

In the example above, we have added a custom person fact to Charles Darwin. The “Type” box can be used 
to record what the fact or event was.



Witnesses to facts/events
We can record that a certain person had some involvement in a fact or event of someone else. For example,
they might have been the witness at a marriage, the beneficiary in a will, or the informant on a death 
certificate. 

Charles Darwin wrote his will on 27 September 1881; probate was granted after his death, on 6 June 1882. 
We have added a “Will” fact and a “Probate” fact to the list of facts for him. If we click on the “eye” button, 
the witnesses dialog appears. This will allow us to select a witness or witnesses, and set their role/roles, or 
delete them from the list. 

Once a witness has been added, the event appears in their own list of facts too, although it isn’t editable 
from there. The following is William Erasmus Darwin’s fact list:



Multiple partners or spouses
Pedigree Forge easily handles multiple spouses or partners. In the following example, we already have one 
spouse, and are going to add a second. Clicking on the  ⋮ button next to the “Status” box, gives various 
options to add a new spouse. 

We can then add the information on the new spouse:

The dynamic chart will now show both spouses. As is the convention, they husband is flanked by the two 
wives:



If we navigate to make Thomas Hardy the active person again, we can see that he now has two spouses 
showing:

At present, Florence is the active spouse. We can use the drop-down list to make Emma the active spouse 
again.

Spouses or partners should be in chronological order. In the above example, Florence Dugdale is 2 of 2 and 
Emma is 1 of 2. The current spouses can be “moved up”, or “moved down” in order using the  button , ⋮
next to the “Status” drop down.

Both marriages are shown in Thomas’ fact and event list. The one for the active spouse is shown with 
asterisks around e.g. *Married*, whereas the other is shown without:

 



Adding illegitimate children or children where only one parent is known
Related to multiple spouses is the occasion where a person has had children out of wedlock. Here you might
want to add a child without creating the other parent. In historic genealogy terms, it is just a fact that this 
more usually occurs that the mother is known, but the father isn’t.

To easily handle this option, select “Children” from then “Edit” menu whilst you are editing the known 
parent, then select “Add illegitimate child without father”. The option will be worded slightly differently if 
the selected person isn’t female. This will create a new “family” in which the mother is one of the parents, 
but won’t create a record for the other parent. A new child record will be added to this “family”. The status 
of the “family” will also be set to “Never Married” and the child’s linkage in the family will be set as 
illegitimate.

A similar situation can occur where you just don’t want to create a record for the other parent, but the child
isn’t illegitimate. In this case, there is a similar option on the “Children” item of the “Edit” menu, that 
creates a new “family” where the active person is a parent, but doesn’t create the other parent, and then 
adds the child to this “family”. The status however isn’t set to “Never Married”, nor is the child flagged as 
illegitimate. 

If you need to add more children to either, use the “Add child to this family” option, with the known parent 
as the active person



Arranging children
Children can be added and deleted, from the Children grid, below the main person details. Note: The list of 
children is specific to those with the active spouse (see section on Multiple Partners and Spouses). 

It is best practice in genealogy that children are shown in birth order. This is often obvious if we have the 
dates of birth for them. However, it isn’t necessarily obvious in the case of twins. Also, particularly with 
older genealogies, the birth order might be known (for example children are often listed in seniority in 
wills), but years of birth aren’t.

There are tools in Pedigree Forge to help you identify children that may not be in birth order, automatically 
sort them, or manually move them up and down if required.

In the example above, Pedigree Forge has noted that Marianne is shown after Charles, and as their dates of 
birth are known, there is an error in the ordering (Marianne has exclamation marks around her order 
number). 

The “up and down” arrow button will automatically sort the children into chronological order—so long as 
the dates of birth are known. The in individual up and down arrows will move the selected child up or down
manually. 

It is a common task, particularly before the start of civil registration, to add children based on baptisms from
a particular church, and these are often extracted at the same time. To help with entering this information, 
the “Family Group” dialog can be shown by clicking on the two children button, above the children grid:



This allows dates of birth, and baptism to be edited together in a single place. The final button can be used 
for creating children from a census transcript. See the section Working with Sources section, for further 
information.

It wasn’t uncommon for ancestors to have had a large number of children, all of whom were born in the 
same village. If you have added a number of children, with approximate dates of birth, but no place of birth,
these can all be set at once. First, ensure that you have the correct parents selected, with one of them as 
the current person in the edit panel, and the other as the selected spouse. Then click on  the “Set All 
Children’s Place of Birth” option from the “Tools” menu:

The “Bulk Set Children’s Place of Birth” dialog will allow you to enter the place of birth, and Apply will do 
the bulk change.

Note: only children with no place of birth for the current couple will have the information added. If a child 
already has a place of birth, it will not be added. 



Deleting people
Sometimes you will have made a mistake, and need to delete a person from the project. There are various 
ways you can do this, but one way is by making sure the person you wish to delete is the currently selected 
person (i.e. it is them that is shown in the edit panel). Then select “Delete Person” from the “Edit Menu”:

You will be prompted to confirm:

Click “OK” will delete the person from the database. If you realise you have made a mistake, before having 
made any other changes, you can use “Undo” from the “Edit” menu. 



Unlinking people from spouses or parents
If you have linked to people together, either as spouses, or as parents, by mistake, you can unlink them. This
will remove them either from being a spouse in the currently selected couple, or from the family in which 
they appear as child.

Ensure the person you wish to unlink is the active person, i.e. they are the person who appears in the edit 
panel.  Then select the option required from the “Edit” menu. For example, to unlink from the current 
spouse, choose “Spouses” > “Unlink...”.

Note: there are two options: “Unlink from spouse and children” will unlink the currently selected person 
from this family with a spouse/and or children; “Unlink spouse from me” will unlink the spouse from this 
couple, leaving the current person still linked to any children.

You will be prompted with a dialog to confirm you are sure, and then the unlink will be applied.

If you have made a mistake, you can use “Undo” from the “Edit” menu to undo the unlink, so long as you 
haven’t made any other changes in between.



Editing visually via the family chart
Many editing actions can be done in more than one place. It is often convenient to edit people from the on-
screen family charts. To do this, right clicking on someone in the chart (when the chart isn’t in edit mode), 
will display a pop-up menu with various options:



Couple status
The status of a couple is a complicated thing—perhaps more so in modern times than when entering 
ancestors.

By default, when you enter two people as a couple, the assumption made by Pedigree Forge is that they are
married, and will be referred as such in reports. This is because that was the most normal situation in the 
past. So, a couple are assumed to have married, even if a marriage fact hasn’t yet been added.

If a couple had never married, then select “Never Married” from the “Status” drop-down, next to the 
spouses name:

Couples that never married are shown on charts with an “x” symbol, rather than an “=” symbol. 

In modern times, people are more likely to choose not to marry, and so “Cohabiting” can be selected. They 
are shown on charts with the usual “=” symbol, which is more polite, but reports will use terms like partner, 
rather than stating a marital relationship. 

The “Placeholder” options is used if you know someone had several children, but you aren’t sure by which 
spouse they were conceived. 

To indicate that any couple separated, or a married couple divorced, add a separation or divorce fact to 
their facts and events:

The date can then be added, and citations linked, like other facts or events.

Marriage annulments can also be added as a fact/event, but as this is an uncommon type of fact, it has to 
be added from the “Add Couple Fact” section of the “Facts” menu.

The use of the word “marriage” is a generic umbrella term that covers more than just traditional marriages. 
Subtypes of “marriage”, for example: “civil partnership”, “common law”, can be selected from the fact 
editing section:





Husband or wife
Pedigree Forge allows same-sex couples, and doesn’t usually distinguish between the “husband” or “wife”, 
except in one specific scenario, as outlined below. The “husband” can be female and the “wife” can be male
so “Partner 1” and “Partner 2” might be better terms. 

Traditionally on family charts, the husband is placed to left of the wife, unless there is more than one wife, 
in which case the husband is flanked by the wives. Pedigree Forge uses “husband” and “wife” for this 
placement when creating charts. 

By default, when creating a couple, the male is set as the “husband” and the female as the “wife”. If no sex 
has been assigned, the first of the couple is set as the “husband” and the other as the “wife”.

You are able to switch the roles for the active couple, if you prefer them to be represented the other way 
round on charts. First, ensure that the person being edited is one member of the couple, and the current 
spouse is the one who you wish to swap. Use the “Edit” menu to selected “Spouses” and “Swap roles”.

Technical note: these roles are also used when importing and exporting to GEDCOM, i.e. the “husband” is 
exported as the HUSB tag and the “wife” as the WIFE tag, likewise, when importing from GEDCOM, these 
tags are imported in this way. This is an historic artefact of the GEDCOM format. 



Multiple facts and events that usually only occur once
Two help prevent common errors, Pedigree Forge, by default, will only allow one occurrence of a fact or 
event that usually happens once. For example, nearly always, the same couple only married once, so if you 
go to add a second marriage for the same couple, Pedigree Forge will stop you as it is probably a mistake. In 
the example below, the active couple already have a marriage fact, so the option to add another is 
unavailable (greyed out text) from the facts menu:

However, some couples did marry more than once. It isn’t unheard of for a couple to marry, get a divorce, 
and then later remarry. For situations such as this, where you do really want to add a second marriage 
event, use the “Add Special” option from the “Facts” menu. 

The following example is for Elizabeth Taylor, who was married several times, including twice to the same 
man, Richard Burton. When Richard is the active spouse, there are two marriage events (1964 and 1975), 
both for the current couple. We can set one of these as the “preferred” date, i.e. that which will be shown 
in charts and used by default. To do that, right click on the item in the list then select “Make preferred 
marriage”. 





Personal names
By default, Pedigree Forge allows names to be entered as Forename(s) in one field, then a surname in the 
next:

For users familiar with other genealogy software, you may prefer to enter names in a single field, with the 
convention that the surname is enclosed in forward slashes. To switch modes, select “Options” from the 
“Tools” menu. The option is on the “Program” tab:

 

Names can then be entered in the combined single field:

This preference is saved, so you only have to do it once. 

More naming options can be found on the “Current Person Other Detail” dialog, accessed from the ⋮ 
button, next to the name:



Nicknames

It is quite common for someone to be known by a nickname. Charles Darwin’s brother, Erasmus Alvery 
Darwin, was allegedly known as “Eras”. The above example shows how the nickname can be entered. 
Entering a name here will then show it as a nickname on charts and in reports for example: 

Usually, in reports, people are referred to by their full given name. However, if the “Prefer nickname” check 
box is set, then the full given name is only used in titles, and in normal narrative text, the nickname is used. 

Although there are no hard rules, a nickname is usually something other than one of the formal given 
names, or possibly a shortened variant of one of them. Someone called John, might have a nickname of Jack
for example, or Elizabeth, might have a nickname of Betty. 

Known by second given name

It isn’t uncommon for someone to be better known by their second given name. The “First name unused” 
check box on the Current Person Other Detail dialog, can be checked to indicate if this is the case: 

The full name will be used in narrative reports in formal situations, but the next given name will be used 
most of the time.



Call name

A call name is the name someone was commonly known as, but more formal than a nickname, or not just 
dropping of their first middle name, although the distinctions are blurred. The call name is used in most 
occasions within narratives, after they have been introduced by their full name.

Surname variants
It isn’t uncommon to find an ancestor’s surname written in a variety of ways. These variations are 
sometimes simple mistakes made by the clerk, but can vary quite a lot on occasions, and it is useful to 
document them. Christopher Marlowe, for example, had his baptism recorded as Marlow and on one 
document, signed his name as Marley. If we wanted to record this, we can use the surname variants box, on
the “Naming” tab of the Current Person Other Detail dialog:

Multiple variants can be entered, separated by commas. 

Surname certainty

It is convention to enter ladies with their maiden surname. For more distant ancestors, we sometimes don’t 
know this for certain. For example, we may know that a lady was a widow (as she was recorded as such 
when she married), but we don’t know her original maiden surname. Commonly, prior to the start of civil 
registration, the source of the mother’s surname is based on a marriage, and we might have found a 
possible marriage, but not be certain it is the correct one, and so unsure of the mother’ surname. We can 
use the Surname certainty or type box to indicate this. The surname is then treated with caution in 
narrative reports, and shown with a question mark on charts, if applicable.



Alias names

Alias names are full names that a person was also known by. For example, they may have changed their 
name, either due to legitimate reasons, or adopted an alias to try and intentionally hide a former identity. If 
a child was born before his or her parents married, then their birth might have been registered under the 
mother’s maiden name. It wasn’t uncommon for people to change names when they emigrated to another 
country, to integrate with the local population. 

An alias name and type, can be selected from the “Naming” tab of the “Current Person Other Detail” dialog,
accessed from the ⋮ button, located next to the name field.

Pedigree Forge only currently supports one alias per person. 

Translated name
Pedigree Forge is designed to mainly work with British conventions. It is possible to enter a name in a 
different language, which will then be shown in charts and listed in reports (subject to support in system 
fonts). 

In the example below, a Hebrew name has been entered, and is shown on the accompanying charts. 

Note: Hebrew is a right-to-left language—entering text in Hebrew will insert each letter at the left end of 

the text, which is the opposite of entering English text. This is the only place that Pedigree Forge will handle 
bi-directional text correctly. 



Formal titles, name prefixes and suffixes

Formal titles, name prefixes and suffixes can be added and are then used in charts and narratives. These are
added in the same place: The naming tab of the “Current Person Other Detail” dialog, accessed from the ⋮ 
button, located next to the name field.

The Civil/Noble Title field is completely free form. Some suggestions might be: “Mayor of London”.

The Name Prefix and Suffix fields have a pre-populated list of some common prefixes and suffixes from 
which to choose, but also allow you to enter your own if you need something from outside this list. 

Some example of prefixes include: “Dr.”, “Rev.”, “Sir”, “Capt.”, “Lady”. Some examples of suffixes include 
“MBE”, “MD”, “Senr.”



Uncertain parentage
Even after thorough research, sometimes someone’s parentage might be uncertain. Conventions have 
developed that this sort of information is useful to capture (as the proof might one day be forthcoming), but
to distinguish that there isn’t enough proof to be sure. These connections are often shown on family charts 
with dashed or dotted, rather than solid, lines. This can be set via the “Certainty” box on the “Families” tab, 
of the “Current Person Other Detail” dialog, accessed from the ⋮ button, located next to the name field.

In the example above, the “Family As Child” certainty has been set to possible, and so the connection 
between Peter and his parents is shown with a dashed line, rather than a solid line.

Parental linkage
Not all parental situations fit into the two biological parents scenario, with step-parents, foster-parents, 
adoptive parents, all potentially needing to be recorded. More information on adoption can be found in a 
separate section, but different types of linkage can be recorded in the “Type” drop down box of the 
“Families” tab on the “Current Person Other Detail” dialog, accessed from the ⋮ button, located next to the 
name field.



The use of these will effect how narratives are written. Suggest uses are as follows: 

Adopted: Use for the adopted parents of an adopted person—see section on adoption for more 
information.

Birth: Use for the birth parents of an adopted person—see section on adoption for more information. It is 
suggested that this isn’t used for non-adopted persons, as birth linkage is assumed to be the default. 

Foster: Use for the foster parents.

Sealing: Do not use—included for GEDCOM compatibility only.

Illegitimate: Use to record that the child was born out of wedlock. It is suggested that this is only used in 
historic scenarios, for example, when it was recorded in a parish register. This is mentioned in narrative 
reports. 

Posthumous: Born after the death of the father. This is mentioned in narrative reports. 

Legitimised/prenuptial: Use to record that the child was born before marriage, but that the parents 
subsequently wed. In narrative reports, the wording would reflect that the child was born to a couple that 
later married. 

Supposed: It isn’t uncommon in genealogy to be certain about a child’s mother, but there may be some 
doubt about the father. Supposed is used to show that there is quite a lot of doubt about the child’s 
paternity. Also see “Reputed” and “Nominal”.

Reputed: It isn’t uncommon in genealogy to be certain about a child’s mother, but there may be some 
doubt about the father. Reputed means that the father seems to accept the child as their own, even if the 
evidence isn’t strong enough to be certain. Also see “Supposed” and “Nominal”.

Nominal: It isn’t uncommon in genealogy to be certain about a child’s mother, but there may be some 
doubt about the father. Nominal means that the father is named as such on some documents, perhaps a 



marriage certificate, but evidence suggest that he may not be the biological father, perhaps the step-father. 
If the man is definitely the step-father, then the records should be created to reflect that, i.e. the child 
should be linked to the mother only, and the step-father relationship implied by her being married to the 
said man. Also see “Reputed” and “Supposed”.



Twins and multiple births
Pedigree Forge will usually automatically recognise that a child was part of a multiple birth—so long as the 
dates of birth are the same. The convention on family charts is that multiple births are drawn linked to their 
parents from a common stem, whereas other siblings have a stem each:

In the following example, Kate and Grace have been automatically identified as twins, because they have 
the same date of birth (1856):

If no dates of birth had been entered (perhaps they weren’t known), Pedigree Forge would not have been 
able to pickup that Kate and Grace were twins, although this fact might have been known. 

The can be manually set to be from a multiple birth, using the “Families” tabe of the “Current Person Other 
Detail Dialog”, accessed from the ⋮ button, located next to the name field:

Note: both Kate and Grace have to be set as being a multiple. 

The “Not multiplet” check box can be used in the reverse situation—to stop Pedigree Forge from joining too
children together as a multiplet—perhaps we only have approximate years of birth for two children which 
were within the same year (Pedigree Forge would assume they were twins), but if we know that isn’t the 
case, we can flag them as not a multiplet.



Adopted persons
Adoption is a complex and sensitive subject. Different adoptees have different views about how they want 
to trace and document their ancestry, and will often want to explore both their biological and adoptive 
family history. That said—particularly with the increasing use of DNA in genealogy—there is a need to 
distinguish genetic from adoptive relationships. 

How best to document and cater for adoptees is on going work in Pedigree Forge, and so if you have 
personal experience, please make contact, as it would be great to hear your thoughts. 

The way adoption is handled in Pedigree Forge will depend on how central it is to the family being 
researched. 

At the most simplistic level, someone can be flagged as being adopted by setting the “Parental linkage” to 
adopted—see the section on Parental linkage. This will then show adopted on family charts and in narrative 
reports. 

If more information is known about the adoption, then an adoption fact/event can also be added, using the 
“Fact” menu, then selecting “Add Person Fact” and “Adoption”. Adoption facts allow storing information 
about the adoption, such as dates, and links to sources. 



Adoption facts also allow the family adopting the child to be specified and which (or both) of the couple 
adopting the child. (This is based on the mechanism in GEDCOM). 

Note: A child with an adoption fact still needs to be linked to parents in the usual way. Setting the family in 
the adoption fact doesn’t create linkage to the parents.

The above only cover the case where only one family: either the adoptive or the biological family is being 
followed. Pedigree Forge does allow a person to be linked to two families where they are a child, and so 
both can be explored.

To add another parent or set of parents to a person, use the “Other Parents” item on the “Edit” menu, 
whilst editing the adoptee.



The definition of which are the “primary” and which are the “other” parents can be changed—the 
“primary” parents are those currently being worked on, and this allows easier navigation. The “other” 
parents are those not currently being worked on. Use the “Swap primary and other parents” option on the 
menu to switch between them. 

Assuming that one set are birth parent(s), and the other are adoptive parent(s), then the relevant linkage 
should be set for each set, i.e. “birth” or “adopted”, as described at the start of the adoption section.

When drawing descendant type charts, and lists of children in narratives, the adoptee will be shown on 
those for both sets of parent(s).

When building charts that follow ancestry back (for example birth briefs), there is an option available on the
“Chart Properties” panel that show which (adopted, birth or foster)  should be followed on that particular 
chart. This is in the “Miscellaneous” section on the “Person” tab:



When building reports, configuration can be set to follow the birth then adopted/adopted then birth, only 
adopted, or only birth families—see section on reports. 

Technical note: At present, Pedigree Forge only supports two sets of parents. This keeps the user interface 
as simple as possible, for something that is already complex. Future extensions may allow more families to 
be supported. 



Including sex on family charts
Typically, sex isn’t included on a family chart, but there are a few occasions when it is useful. For example, 
where a child died very young, and wasn’t named, or if someone had a given name that people are more 
familiar with being of the opposite sex. For example, Philip and Nicholas are traditional mostly male names, 
but both have been used as female names in the past. 

This can be set on the “Main” tab of the “Current Person Other Detail” dialog box, accessed y clicking on the
 ⋮ button next to the name box.

This flag also includes the sex when listing children in reports. 

Pronouns
Pedigree Forge allows you to specify pronouns for individuals to promote inclusivity and respect for modern
identities. By default, pronouns are not displayed on family charts, and narratives use pronouns based on 
the individual's recorded sex. However, you can enter custom pronouns—subject (e.g., 
“he/she/they/xe/ze”), object (e.g., “him/her/them/xem/zir”), possessive (e.g., “his/her/their/xyrs/zirs”) and
reflexive (e.g., “himself/herself/themselves/xemself/zirself”). If at least the subject and object pronouns are
entered, they will appear on family charts and be used in narratives.

This feature is primarily designed for modern people where pronoun usage is applicable. For historical 
ancestors, pronouns are optional and need not be specified unless relevant. This ensures that modern 
values are respected without imposing them on those from different historical or cultural contexts.

To set pronouns, use the "Naming" tab in the "Current Person Other Detail" dialog. Thoughtfully consider 
whether pronouns are important for the individual in question, and complete the fields as needed to reflect
their identity accurately. Tooltips are shown above each field to show which tense of pronoun should go in 
each box:



Technical note: Some people use different pronouns at different times. It isn’t clear how this could be 
incorporated into reporting functionality, where decisions about which pronoun to use in which context 
might apply. 



Gender and sex
The sex of each person in your Pedigree Forge project is set as one of the first fields entered after their 
name, from the main person editing panel. This is designed to relate to the official sex of the individual. 

Gender, whilst often aligned to sex, is not the same, and can be recorded separately. This field is accessed 
on the “Current Person Other Detail” dialog, which is shown by clicking on the  button next to the current ⋮
person’s name:

There is a list of some frequently used genders, but other values can be entered if none of these are 
appropriate. 

Also refer to the section on pronouns. 



Associations between people
Family relationships are entered by linking people as children or parents, building a tree. For example, the 
relationship between grandparents and grandchildren is inferred because they are linked via the parents 
between. There area some types of association between people that might not be genetic, or might vary. 
For example, you might wish to record who the Godparents of someone were, or who was an heir to a title. 
These associations are added independently.

To associate two people in a this way,  use the “Current Person Other Detail” dialog, which is shown by 
clicking on the  button next to the current person’s name, ⋮ then select the “Associations tab”:

Use the buttons at the top of the grid to select people to associate, delete an association, or edit its details. 

When adding/editing an association, the description of the association can be selected from the pre-
populated list, or you can use your own:



Most relationships are for your own reference. Currently, those related to inheritance, i.e. heir, coheir, 
heiress and coheiress are used by the reports and charts. They are intended to show inheritance of a title as
was often shown in old pedigrees, and will expand phrases such of “son of” or “daughter of” to “son and 
heir of” or “daughter and coheiress of” in certain circumstances:



Dates

The Basics
Dates should be entered into the relevant fields in the form “dd mmm yyyy” for example:

1 Jan 1940

The date input fields are more flexible than this, and can also recognised various other versions, for 
example 1/1/1940 or 1.1.1940, but will be corrected to the normal form as shown above. Dates can also be 
entered as only a year, or month and year. 

Some dates aren’t known exactly, for example, you might have an estimated year of birth. So dates can be 
entered as approximate:

Abt 1940

Will be interpreted as “about 1940”. This will be shown on charts as “c.1940”, for circa 1940. NB: 
alternatives for approximate are Cal (for calculated) and Est (for estimated). These are still shown on charts 
as “c.” but might be useful for documenting how a date was arrived at. 

It is quite common to have an age at a particular date. To help enter this situation quickly, the date fields 
allow a basic formulae to be entered, starting with the = symbol. For example:

= 1921-8

will be corrected to

Abt 1913

Sometimes, a date is a range. This can be entered using “From” and “To”, or either alone. For example:

From 1 Mar 1852 to 10 Mar 1853

Dates can also be entered as before, after, or between:

Bef 1850

Aft 1860

Bet 1850 and 1860

Delving Deeper
Dates can also be entered in various other formats, which can convey particular meaning. 

General Register Office Quarters
The General Register Office have used a long established system of indexing dates of birth, marriage and 
deaths by the quarters in which the event was registered: M (March), J (June), S (September) D (December).
Often, these are the most precise date we have for an event, if the original certificate or extract hasn’t been 
obtained. The GRO quarters can be entered followed by the year, for example:



M1852

Would infer that the event was registered in the March quarter of 1852. This doesn’t mean that the event 
took place in that quarter—as births could be registered up to six weeks after the event, so a birth 
registered in M1852, might have taken place between mid-November 1851 and late-March 1852. Technical 
note: this isn’t supported in GEDCOM, so on export to GEDCOM there is a loss in precision.

In addition to M/J/S/D, “early”, “mid” and “late” are also supported. 

Decades

Sometimes a year is a too precise for an estimate, so approximate dates can be entered as a decade. For 
example:

1910s

Would indicate that the event took place in the 1910s. 

Decades can also be prefixed with “early”, “mid” or “late”.

NB: Not supported in GEDCOM—there will be a loss of precision on exporting to a GEDCOM file. 

During the Reign Of

Very old genealogies have very approximate dates; often only as accurate as the reign of an existing 
monarch. An example is shown below:

Temp Hen VII

Would mean in the reign of Henry VII. NB: Not supported in GEDCOM.

School terms or legal periods

Some events might be dated in scholastic or legal “terms”, for example, matriculating at a university. These 
can be entered with the term and year, for example:

Michaelmas 1580

The supported terms are: Michaelmas, Epiphany, Hilary, Trinity, Lent, Easter, Summer, Candlemas.

The Gregorian (New Style) and Julian (Old Style) Calendars
The calendar used in the west today is the Gregorian calendar, also known as New Style (NS). However, this 
wasn’t always the case. The Gregorian calendar was adopted on different dates in different countries, for 
example, 1582 in most of Catholic Europe, but 1752 in  Britain and its dominions; prior to this the Julian or 
Old Style (OS) calendar was in use. 

The Gregorian Calendar was adopted to correct errors in the Julian Calendar, whereby the choice of leap 
years (compared to the earth’s journey around the sun), had caused the dates to slip back compared to the 
seasons. By the 1500s, this amounted to around 10 days. When countries adopted the Gregorian Calendar, 
they also skipped days to bring them back in line.



The varying dates of adoption in different countries, regions or city states, means that it isn’t enough to 
know a date of when an event occurred, but also the calendar in use at the time.

It is customary in genealogy, and best practice in history works generally, to record the calendar date as per 
the system in use at the time, and not make any adjustments for skipped days.

Pedigree Forge allows the entering of Old Style and New Style dates using the suffixes OS and NS as 
appropriate. For example:

1 Sep1600 OS

Would be interpreted as 1 September 1600, as per the Old Style (Julian) calendar, and is  equivalent  to 11 
September 1600 in the Gregorian (New Style) Calendar. 

1 Sep 1600 NS

Would be interpreted as 1 September 1600, as per the New Style (Gregorian) calendar, and is equivalent to 
22 August 1600 in the Julian (Old Style) calendar.

When no specific calendar is specified, then Gregorian (NS) is assumed. It is possible to change this 
assumption from  the “Dates” tab of the options dialog (from the menu bar: Tools > Options). This only 
changes the interpretation of the dates, no data is changed. 

New Style and Old Style dates can also be combined with dual years, which indicate Modern Style, see 
below.

Technical Note 1: OS and NS dates are imported/exported to GEDCOM with the @#DGREGORIAN@ and 
@#DJULIAN@ escape sequences (GREGORIAN and JULIAN in version 7.0). If no calendar is given in the data,
then no assumption is made on import/export—the date is left as was written. 

Technical Note 2: It would be desirable to reject the “skipped” dates when the change was made from old 
style to new style calendars, but this is different depending on when the change was made and even 
knowing if the date is OS or NS doesn’t help—we also need to know where the event was recorded. For 
example, in Britain, 2 September 1752 was followed by 14 September 1752, the intermediate 11 dates not 
being valid, whereas in Spain, these dates did “exist”, the “missing” dates being 5 October to 14 October 
1582 inclusive. Dates that don’t make sense are accepted (because they do exist in some places). Warnings 
are shown in “balloon tips”, and in validation reports, which are also combined with knowledge on where 
the event took place. General warnings are issued if the place can’t be determined, or if there is no 
knowledge of the convention in a particular place. 



The First Day of the New Year (Modern Style) vs. Other Styles
Sometimes conflated with old and new style dates—possibly because in England the two were both 
adopted around the same time—is the day on which the new year began. The west now use 1 January as 
the first day of each year, which is term Modern Style. This wasn’t always the case; prior to 1752 in England, 
the new year started on 25 March. This is is termed Annunciation Style or Lady Day Style. Scotland adopted 
the Gregorian calendar in 1752, but had started using Modern Style year numbering in 1600. As with new 
style, dates, modern style year numbering began in different times in different places, for example, in 
France, the Edict of Roussillon stated that from 1564, the new year was to start on 1 January—prior to that 
it had been reckoned differently in various regions of the country, some including: Christmas Day, 1 January 
(the Feast of the Circumcision), 25 March, Holy Sunday and Easter. To make matters more complicated, as 
Easter moved each year, if it was later the following year, than the previous, some dates between occurred 
twice in the same year.

Even in England, sometimes certain people had adopted the modern style numbering early than 1752, so 
the only way to tell is from context in an original document, such as when the year changes in a range of 
parish register entries. 

To allow for modern style, vs. the various other styles, it is customary to use dual years, so it is clear that 
this has already been taken into consideration. This was even sometimes done at the time. 

Pedigree Forge allows entering of both years, for example:

2 Feb 1644/5

Would indicate that this event took place in 1645 modern style, but is recorded in the original document as 
1644. If only a single year is given, it is assumed  the conversion to modern style has already been applied.

Technical Note 1 Dual dates are supported in GEDCOM in the Gregorian calendar, but they are only really 
used with the Julian calendar, which is an error in the GEDCOM specification. Pedigree Forge dual dates are 
exported and imported to GEDCOM in either calendar. Version GEDCOM version 7 does not support dual 
dates. When version 7.0 export is requested, the dual date is exported as a phrase, and the modern 
(generally higher) year is used. Dual dates are not automatically converted to “Old Style” as this risks 
automatic conversion of only around a quarter of the dates, which would potentially cause logic errors 
compared with the non-dual dated (and therefore non-converted) dates. 

Te  chnical Note 2   It would be desirable to reject when dual years are given after 25 March 1752, and only for
dates between 1 Jan and 24 March, but this is an over simplified view, and is location dependent. These 
dates are therefore accepted, but warnings are issued in the form of “balloon tooltips” and in validation 
reports, which also take into consideration knowledge of the place where the event took place. General 
warnings are issued if the place can’t be determined, or if there is no knowledge of the convention in a 
particular place. 

Te  chnical Note   3   Most of the dates used for the first day of the new year are “after” 1 January, so modern 
style is the year with the higher value, for example 14 February 1600/01. However, in “Christmas Style”, i.e. 
new year before 1 January, the modern year is the lower of the two values. This isn’t covered by the 
GEDCOM spec,  but the logical extension is that it is the second year that is the “modern” style year, and the
first year that is the “original” year. So, a “Christmas Style” date would look like: “27 Dec 1532/1”. This is 



how Pedigree Forge handles “Christmas Style” years. Warnings are always issued when the second year 
(modern) is lower than the first (local).

Technical Note 4 Leap year dates are validated correctly and rejected. This does prevent 30 February 1712 
from being accepted—it is an illegal date in both Gregorian and Julian calendars but is a legal date in the 
Swedish calendar, due to the way that the transition was first handled. 

French Republican Calendar
Pedigree Forge allows entering dates using the French Republican Calendar, in use from 1793 to 1805. Years 
are numbered from 1 to 14  (1793 to 1805), and the months have different names. For example:

4 Vend 1 FR

Would be 4 Vendemiarie in Year 1.

11 Nivo 14

Would be 11 Nivose, in Year 14.

The recognised moths abbreviations are: Vend, Brum, Frim, Nivo, Pluv, Vent, Germ, Flor, Prai, Mess, Ther, 
Fruc, Comp.

The FR is optional, French Republican dates can be recognised by the month names. 

Technical Note 1 French Republican Calendar dates are imported/exported to GEDCOM with the 
@#DFRENCH R@ (FRENCH_R in version 7).

Hebrew Calendar
Pedigree Forge allows entering dates using the the Hebrew calendar, with the suffix HE, for example: 

20 Csh 5636 HE

The abbreviations for the month names are: Nsn, Iyr, Svn, Tmz, Aav, Ell, Tsh, Csh, Ksl, Tvt, Shv, Adr, Ads

The HE is optional, Hebrew dates can be recognised by the month names. 

Technical Note 1 Hebrew Calendar dates are imported/exported to GEDCOM with the @#DHEBREW@ 
(HEBREW in version 7).

Dates Before the Common Era
Dates “before the common era”, can be entered with the suffix BCE. 

Technical Note 1 This feature will export and import from GEDCOM, but isn’t often used in western 
genealogy, so isn’t well tested. 
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[2] A Practical Guide to Dating Systems for Genealogists, Kenneth K. Smith.



[3] Dates and Calendars for the Genealogist, Cliff Webb.

[4] The Gedcom Standard Release 5.5.1, Family History Department, The Church of Jesus Christ of the 
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[5] The FamilySearch GEDCOM Specification, 7.0.15, The Church of Jesus Christ of the Latter-day Saints, 3 
September 2024.



Places
Describing where an event took place consists of two parts: the place (which is the town/village etc.) and 
the address (the actual house, farm or street address). Pedigree Forge follows this convention, and allows 
both to be entered when creating events. 

The address is usually only shown in detailed reports, whereas the place is usually shown on charts too 
(charts generally only contain a summary of information). 

In the example below, Luddenham, Kent, is the “place” and Oare Mill, is the address:

Pedigree Forge will accept any value in the places field, although it will warn you if it doesn’t understand the
place, or it isn’t in its database (yet). 

The recommended way to enter places (and the way that they are suggested by the auto-complete) is as 
two parts: the town or village, then a comma, then the county/region/state/department eg:

Ashford, Kent

They can also be entered with the country on the end too:

Ashford, Kent, England

Pedigree Forge knows that Kent is in England, and so can infer the country, without it being entered. 
However, both will be accepted in the place fields, and one won’t be changed to the other, so will remain as
you prefer.

It is not sufficient to just use Ashford, England because there is more than one Ashford in England.

Once you have used a place which is recognised, this will be the top-auto completed suggestion when you 
begin to type the stem in other place boxes during the session whilst you are using Pedigree Forge. Other 
suggestions will be shown below in a drop down list:



If Pedigree Forge doesn’t recognise a place (it isn’t in its database), it will appear in red:

A place can be added to the database via the “Places” panel (select the map-pin icon from the left-hand 
action bar). 

Tip: You can also add an unrecognised place to the database directly from a place field on the person panel 
with the keyboard shortcut Ctrl + Y (or by selecting this option from the “Edit” menu). 

The place will then be considered as verified, appear as suggestions, and not show in red when entered:

Note: A few places can be entered just by themselves. This is usually when there is one specific place that is 
really well-known. There might be other places with that name, but they would always need clarification. 
For example, “Paris” alone would imply Paris in France; if you wanted Paris in Yorkshire, you would need to 
enter “Paris, Yorkshire” This is the way we talk in natural conversation.



TO DO: Allow adding “regions/departments etc.”

Famous Cemeteries
There is one occasion when the place only, not the address being shown on a chart doesn’t make so much 
sense, which is the place of burial. In particular, there are many large London cemeteries, particularly the 
“Magnificent Seven”. The place in which they are located is perhaps less of interest than the name of the 
cemetery. When Pedigree Forge can identify this, the place of burial is shown on the chart as the name of 
the cemetery, rather than the place. For example, “Abney Park Cemetery” is really an address, but is more 
informative than “Stoke Newington, Middlesex”. 

TO DO: Allow a mechanism for users entering these folded places

Which County?
When working with British records, the counties as appearing in Pedigree Forge are the Historic Counties. 
The use of these has gradually eroded over the years, as modern Council Authorities have been confused 
the matter. The problem being that these modern council areas are forever changing, whereas the historic 
counties are as they have always been. It is recommended that you consider using the Historic Counties, 
when recording places in the British Isles. 

This does cause some confusion however, particularly in regard to London, which has absorbed a lot of the 
surrounding places, originally in a different county. For example, Southwark is in the historic county of 
Surrey, and much of the area of “London” north of the Thames is in the historic county of Middlesex. 

Some counties are, or have, been known by more than one name, or by variations in spelling. Either are 
accepted and recognised by Pedigree Forge, but the way that they are output in reports, and charts, or 
suggested from the list of places, can be configured using “Tools” then “Options” from the main menu bar:



Suggestions for Region in Other Countries:

• Australia: States

• Canada: States

• France: Departments

• United States of America: States

[1] The Historic Counties Standard, The Historic Counties Trust https://historiccountiestrust.co.uk/standard



Charts
When you first create a new project, the only chart available is the “dynamic chart”. This follows the 
currently selected person and their immediate family. The current chart is shown (and can be changed) via 
the “Current chart” drop-down list, located on the “Charts” tab:

You can’t edit the dynamic chart, because it is created automatically for you, and changes as you select 
different people in your project.

To create a chart to your own specification, click on the “New Chart” button, also located on the “Charts” 
tab. This will show a pop-up menu to select the mode of chart to create. The simple examples will work 
with “Descendant Chart”.



You will be prompted to select the person to start the chart from—Descendant charts start with someone at
the top and show their descendants below. Your chart will then be created and will be in editing mode. 
Whilst in editing mode, the “Chart Properties” Panel will be shown:



You can change properties of the chart using this panel, and many features can also be actioned on the 
chart itself, using keyboard short-cuts or clicking on the small grey buttons shown for the active family:

Many features are also available by right-clicking with the mouse on a person too, and then selecting 
options from a pop-up menu:

When you have finished editing the chart, you can click “OK” to exit and apply the changes, or “Cancel” to 
cancel the changes that have been made whilst in editing mode, or since the last-time the “Apply” button 
was pressed:

You can return to editing mode by selecting the chart you want to work on and using the “Edit Chart” 
button on the “Charts” tab:



When a family chart is created, the default layout will often create a rather wide chart. However, very 
quickly, charts tend to become too wide, and would require printing out on many sheets of paper. 

Pedigree Forge gives you many tools to make your chart fit a particular paper size. This is the better option 
from a design perspective. 

If you are happy with a wider chart, then just leave the page size as “Auto”. The page size will be made as 
wide (and tall) as necessary. 

Read on if you want to make your charts look better…

The inspiration for how to arrange family charts is taken from two main sources, which are highly 
recommended if you wish to create well presented charts.

1. Family Trees, A Manual for their Design, Layout & Display, by Marie Lynskey.
2. Laying out a Pedigree, by Eve McLaughlin. This is also incorporated as a section in Further Steps in 

Family History, by the same author. 



Important Concept
Some information, for example, names, dates of birth, who they married, etc. resides in the database, and is
changed there through editing the person’s facts and attributes in the database. This would show through 
on any charts on which they appear. 

Other settings are about the display of that person in a particular family chart, or the parameters of what 
belongs in a particular chart, and this is changed when a chart is in editing mode. 

To edit a chart (enter edit mode), use the “Edit Chart” button from the “Charts” tab of Pedigree Forge. 

ID numbers
Every person in the database has an ID number. If they are created in Pedigree Forge (and most of the time 
if the data is imported from a GEDCOM file), the ID of a person will start with the letter “I” and include a 
number. For example, “I5”.

These numbers are shown when editing charts in teal. The current person being edited is highlighted on the
chart. In the following example, Robert Waring Darwin is the current person, and his ID number is I15. His 
wife, Susannah Wedgewood, has the ID I16.

“Families” also have an ID number. A family consist of one or more parent and optionally, any number of 
children. Family ID numbers usually being with an F, and are followed by a number. 



In the above example, the family of Robert Waring Darwin and Susannah Wedgwood is F2. This also 
includes their children: Marianne, Caroline, Erasmus, Charles Robert and Emily. 

People belong to both the family in which they are a child, and one or more families in which they are a 
spouse/partner. Charles Robert Darwin is a child in family F2 and a partner in family F1.

ID numbers are often useful to refer to particular people or families when editing charts, although you don’t
need to use them directly. 



Basic position and width of people on charts
A quick way to help reduce the width of a chart is by altering the position of parents above their children. 

The following is a basic chart, where the parents are centred above their children, which is the default

When in editing mode, if someone is selected, then a range of grey buttons appear around them as shown 
below:

These grey buttons allow you to size and position them.

The “+” and “-” either side of the person’s box will make them wider (“+”) or narrow (“-”). By pressing these 
several times, we can make someone much wider or narrower:

Instead of pressing the buttons, the following keyboard keys can be used instead. 
[+] Makes them wider
[-] Makes then narrower

To return to auto width for that person, use the “A” button or press [A] on the keyboard. This button only 
appears when the width of a person has been changed. 

The arrow buttons (“<<”, “>>” “<” and “>”) position the person or more precisely, the line that links them to 
their children, either left, or right. The double arrows “<<” “>>” move them keeping aligned to the children 
below them, the single arrows “<” and “>” give smaller movements between.



The “C” button centres them above their children.

The “+” and “-” buttons change the default width of their children. Note: if any of the children have had 
their width manually set already, then these buttons only effect the widths of children still at their default 
width.

The “…” button gives access to a pop-up menu, with more options, which will shall cover soon. 

The following keys can also be used, rather than having to click on the buttons:

[Shift] [+] Make children in a family wider (if their widths haven’t already been overridden)
[Shift] [–] Make children in a family narrower (if their widths haven’t already been overridden)
[Left Arrow]: Move the parent(s) to the left by one large space, snapping above other nodes
[Right Arrow]: Move the parent(s) to the right by one large space, snapping above other nodes
[Shift] [Left Arrow]: Move the parent(s) to the left by a small amount
[Shift] [Right Arrow]: Move the parent(s) to the left by a small amount
[C]: Return the parents(s) to their default position above the children
[Home]: Move the parent(s) to above the left most child
[End]: Move the parent(s) to above the right most child

Reducing width
Family tree charts have a tendency to be too wide. Pedigree Forge includes a number of ways to help you 
reduce the overall width of a chart. The first tool is as covered above, changing the positioning and width of 
individuals.

Often, the width of a chart is due to families with a lot of siblings. There are a number of ways that the 
width of siblings can be reduced. A combination of things might be needed to get the best chart.



Stacking siblings
One way to reduce the width is by stacking siblings on top of one another. You would tend to do this if there
are particular siblings whom not much was known, or aren’t so important in a particular chart. To do this, 
click on the person in question, so they are active, then either click the “…” grey edit button, or right-click 
on them. This will cause the following menu to pop-up.

If “Start sibling stack” is selected, the person will change to a stacked view.



Then select the next sibling, click their “…” button, or right-click on them, and on the pop-up menu select 
“Continue sibling stack”. 

Do this for the next few children, will save quite a lot of space.

You might need more than one sibling stack to accommodate all of the children. You can start another 
sibling stack by using the same method, but selecting another “Start sibling stack”.

Siblings can be un-stacked, but again using the “…” button, or right-clicking, and selecting “Don’t stack 
sibling”.



Sibling curl back
Another way of dealing with too many siblings is “curl back”, that is whereby after a certain point, the 
remaining siblings are curled back to another row below. 

In chart editing mode, click on the sibling that you want to be the first curled back, then click on their “…” 
button, or right-click on them. From the pop-up menu, select “Curl back 1 row”.

The selected sibling will then be dropped down to the next row, the siblings continued in the original order. 

To cancel the curl back, again click on the “…” or right-click on the sibling to get the pop-up menu, then click
“Clear curl back”. The siblings should again return to the same row.

Staggered siblings
Siblings can be made to be staggered, with some one row down as usual, and others another row down. As 
before, select a sibling, and use the “…” button, or right click, then click “Drop 1 row” from the pop-up 
menu. You would probably do this for every other sibling:





This can be cancelled by using the “…” button/right-clicking and “Clear extra drop” from the menu. It is 
often useful to also change the row height (see relevant section). 

Bunched siblings
There are (probably rare) occasions, where there might be so many children, and most are not of interest, 
or space is so tight, that rather than naming some of the siblings, it might be better to just refer to them as 
something like “3 sons + 1 daughter”. This is called buching.

To bunch some of the siblings, click on the parent node, so that the drop line linking the parent to the 
children is selected. 

Click on the “Family” tab of the “Chart Properties” Panel, which appears when in chart editing mode, and 
then click on the “…” button to the right of the “Bunch Children” text box. 

A small dialog will appear, allowing you to select which children to bunch. 



When you close the bunch dialog, the chart should update, bunching the children together.

To clear the bunching, use the same process, but de-select all of the children.



Siblings out of sequence
It is best practice for children to be included in order of seniority, from left-to-right (you can sort them 
whilst adding children to the database). However, sometimes, it might be more visually pleasing to draw 
children out of sequence. This is usually only done if some had children of their own, and it is the children 
of the siblings that are causing extra width or wasted blank space. 

To draw siblings out of sequence, make sure the family to which they belong is selected as the active family, 
then choose the “Family” tab of the “Chart Properties” panel, which appears when in chart editing mode, 
and then click on the “…” button to the right of the “Order Children” text box.

The “Select Children Order” dialog box will appear. You can use the arrows to change in which order the 
children will be drawn on this chart only. 



Note: when siblings are drawn out of sequence, small numbers appear next to their names on the charts, 
which indicate that they are out of sequence.

Family double drop
A very useful feature to save space is to “double drop” the descent line from a family, placing the children 
down 2 rows from the parents, rather than one.

In the following example, the child “Ernest”, son of Mary Ann, means that Mary Ann herself, and her other 
siblings, are all pushed to the right. However, if we double drop the descent line from Henry James Smith 
and Eleanor Marden, then Ernest (and consequently Mary Ann and the younger siblings), can all slide left, 
reducing the width. 

Select the family to double drop, in this case it is Henry James Smith and Eleanor Marden. Then either click 
on the “…” for whichever parent is selected, or right-click on them, so that the pop-up menu will appear.



The children of Henry and Eleanor will then double drop, and Ernest will slide right, as will his mother and 
all the later siblings.



Double drop can be cleared by again making sure the family is selected, using the “…” button, or right-
clicking and then selecting “Cancel Family Double Drop” from the pop-up menu, which will appear instead 
of “Family Double Drop” for a family already double dropped. 

When using double drop, it is often worth changing the row height, for which see the section “Row height”, 
this would give something more like the following:



Lifting family bar for better spouse spacing
In the example below, Annie Jones had had a daughter, Elsie, before she married John Smith. To prevent the
horizontal family lines from clashing, by default, The “X” and drop line, which represents Annie’s first 
partner (name unknown), has been pushed some distance from Annie herself, even though the family has 
been moved as far to the left as possible (see positioning section). 

There is an option that allows closer spacing, by lifting up the horizontal line linking the “X” symbol to the 
daughter. This can be found on the “Family” tab of the chart properties panel. When “Allow lifting horiz.l 
family bar” is checked, with the correct family selected, Pedigree Forge can lift the line up and place Annie 
closer to the first partner. This also gives more space on the row above. 





Default amount of detail to show.
Depending on the use of your chart, you might wish to show more, or less information about everyone. Use 
the “Detail” drop down list from the “General” tab of the chart properties to adjust the default amount of 
detail on a chart. 



Amount of detail included for a specific person 
By default, quite a lot of information is included for each person in a tree (assuming that it is has been 
added to the person).

If less detail is desired for a particular person is desired, possibly to save space, then it particular 
events/information can be turned off. 

Firstly, select the person and enter chart editing mode.

Then, go to the “Person” tab of the “Chart Properties” panel, and click on the “…” button to the right-hand 
side of the “Exclude fact(s)” text box. This will show the “Select Information to Exclude” dialog. 



Click on the fact or facts you wish to exclude for this person. In the example below, “Father” and “Probate” 
were selected. 

Showing/hiding surnames
By default, surnames are shown for everyone in the tree (as long as they have been entered).

If you need to save space, then a surname can be hidden for a particular person. To do this, click on the 
relevant person in edit chart mode. Then click on the “…” button, or right-click on them. 

Select “Toggle Surname” from the pop-up menu that appears.

Alternatively, if space is tight throughout the chart, then most surnames can be turned off in one action. In 
chart editing mode, select the “Layout” tab from the “Chart Properties” panel. Then turn off the “Always 
include surnames” check box. Most surnames will then disappear on the chart. The rule that those who 
have children will have their surnames included.



Note: If  the “Always include surnames” is turned off, the step described first, i.e. toggling a surname will 
have the opposite effect, it will toggle a surname on, if it were usually off!

Person specific notes
If specific notes are required on a chart for particular people, these can be added in the “Note” text box of 
the “Person” tab of the “Chart Properties” panel:

Any notes entered here apply to this person, on this chart only. 



Tucking children under their parent
By default, children are shown linked from their parents by a line that drops down from the “marriage” 
symbol, if such symbol appears (also refer to “Folding or not folding spouses”). 

If there is only one parent of a child included in the database, and that parent had no other spouses 
included, then the children are shown as descending directly from that person:

However, if the parent later married someone else, then the children are split out to descend from the 
relevant family. 

 



If the status of Mary’s first family (i.e. that in which she had Jack, is set to “Never Married”, then Jack will be 
shown as descending from her, rather than an unknown first partner:

Also see the section on adding illegitimate children for how this can be achieved directly when adding a 
child. 

Which children (by family group) that are tucked under one of their parents can be overridden from the 
“Person” tab of the “Chart Properties” panel, whilst editing a chart. 

First, uncheck the “Automatic” checkbox, then click on which family groups should be tucked under. In this 
example, if we selected both families, all of the children would be tucked under Mary:





Folding or not folding spouses
By default, spouses are shown next to each other if they have any children, or if there is any information on 
the spouse. 

If there are no children AND the only information about the spouse is their name, then they are folded and 
appear in the same entry, for example: 

However, spouses can for forced to always be folded, or to never fold. Folding spouses can save space. 



First, (in chart editing mode), click on the person who is the descendant on the chart (i.e. person who is 
linked to their parents above. Then, either click on the “…” button or right click on them to show the pop-up
menu. Then select “Never fold spouse” or “Always fold spouse”. These options can also be cleared in the 
same way, or, use the check boxes on the “Person” tab of the “Chart Properties” panel: 

The two examples above would show as follows:



Row heights/top offset
By default, all rows on a descent family tree chart are the default row height. This can be found, or adjusted 
by going into edit chart mode. On the “Chart Properties” panel, select the “Layout” tag, then use the arrows
to change the “Default Row Height” box.

This can also be done from the keyboard, When in “Edit Chart Mode”, and the chart is selected, the 
following keyboard codes will work:

[Shift][Down Arrow]: Make the default row height larger
[Shift][Up Arrow]: Make the default row heigh smaller

The following also work:

[Down Arrow]: Move the “top offset” of the chart downwards, i.e. moves the whole chart down
[Up Arrow]: Move the “top offset” of the chart upwards, i.e. moves the whole chart up

Sometimes it might be desirable to change the height of certain rows. For example, giving extra height to a 
row can help preserve horizontal space, by allowing you to make the people in that row narrowed. Reducing
the height of rows where generations have been made to span more than one row (see “Family double 
drop” and “Staggered siblings”) can also help highlight to the user that a generation spans more than one 
row. Also, if very little is known about those in a particular generation, perhaps that at the very top of the 
tree, then making that row shorter helps keep visual balance and save vertical space.



To specify the height of particular rows, use the”Individual Row Heights” section from the “Layout” tab of 
the “Chart Properties” panel. The values entered are in millimetres. The row numbers to which they relate 
are drawn on the edge of the chart:

To override a particular row, check the “Override” checkbox for the row, and adjust the height. 

Note: If extra rows are added (for example by implementing other double drops, or adding more 
generations back further, it will be necessary to manually update any row heights.



Starting charts with multiple people
Most descendant charts start with one person (or family) at the top. That is, they generally show 
descendants of a particular person. Usually, this is the clearest way of organising a descent chart.

It is possible to start with more than one person, and then to have the charts join. Theoretically, Pedigree 
Forge can handle many starting people, but in practice this becomes hard to work with the more that are 
added. 

First, create a descendant chart, starting with the first person who should head the chart as usual. 

Select the “General” tab from the “Chart Properties” panel, and then open the “Advanced Parameters” 
section by clicking on the little arrow:

Clicking on the “…” button for the 2nd start person will enable you to select a second person to start from. 



Select the person from the list of people in the database, and click “Ok”. 

The chart should redraw showing two starting people.

In the above example, John Smith was the original start person for the chart, and Walter Jones (ID I11), was 
the 2nd start person. As Elizabeth Jones appears on both charts, she is shown twice, connected with arrows.

This is one of the occasions when it might be better to draw children out of sequence, i.e. the chart would 
benefit from Elizabeth Jones being the first one drawn (see Siblings out of sequence). So we can move her 
to the left-most sibling of her family:



In situations such as that above, we can merge Elizabeth Jones’ entry into a single person. To do this, make 
sure that Elizabeth is the selected person, and on the “Chart Properties” panel, select the “Person” tab, and 
check the “Merge with duplicate” check box, which is in the “Miscellaneous” section:

Elizabeth Jones’ entry will then be merged:

Important: The merge duplicate will work even if Elizabeth Jones’ wasn’t the first sibling, or if there were 
other people between her and her husband. This is one of the few occasions on which Pedigree Forge will 
fail to layout a chart properly, and might cause lines to cross in error.



In the simple case above, the two starting people and the person who appears on both charts, are at the 
same number of rows from the top. However, if the Jones family only started with William Jones, it would 
create a strange looking chart.

To overcome this, one or other of the starting people can be offset by a number of generations (or rows). To
do this, from the “Chart Properties” panel, select the “General” tab, and use the “Offset” boxes to adjust. 

In the above example, offsetting the 2nd start person by 1 generation (row), will once again align Elizabeth 
Jones, and we can merge her entry as before:





Constraining who appears on charts—stop charts from getting too big.
By default, a descendant chart starts with the selected person, and continues down 7 generations, or, if 
there aren’t 7 generations of descendants, will stop earlier.

Number of generation on a chart
The number of generations to include, can be set from the “General” tab of the “Chart Properties” panel:



Other ways to stop following branches

It is also to have more fine-grained control of stopping who appears on charts. For example, on a particular 
chart, you may not want to include the descendants of a particular person, even if they are in the database. 
There are various ways that this can be done. 

Starting with the following chart, we will look at ways various ways to stop the chart from show William’s 
descendants, or reduce the levels of detail on him or his wife (and her other spouses). 

First, make sure that the person who you want to stop at is selected (in the above case, William Smith who 
married Lucy Evans), and go to edit the “Chart Properties” panel, and select the “Person” tab. 



If we enter text in the “To Text(stops)” box, the chart will not follow William’s spouses/descendants at all, 
but will instead draw a down arrow and the relevant text:

This is useful if you want to break a large chart into multiple smaller charts.

We can also use the “Stop at me:” drop down box to set various other ways in which the chart should stop 
with William. 

Default: Stops with William, but shows his wife folded into his entry and the symbol used to indicate that 
there were children not shown here.

Leaf: Just shows information on William, ignores any spouses or children.



Quiet: Includes the spouse (folded), but
ignores children.

No children: Includes the spouses and step-spouses, but ignores children.

Ignore: The selected person is completely ignored, as though they don’t exist. The person in question, nor 
any spouses or children, is not shown on the chart at all (no picture, as William isn’t included at all!)

Amount of detail on step families or other spouses of spouses.
It is also possible to control if a step-family, or other spouses of spouses, are shown. 



Using the example from above, with William Smith (who married Lucy Evans), selected and in chart editing 
mode. Select the “Person” tab of the “Chart Properties” panel. Then select the “Step Familes” drop down 
box (in the Spouses and Children section) to select various options.

Exclude: The step-family is excluded completely

Spouses: The other spouses are included, but not their children.



Spouses & Kids: This shows the step family, with spouses and kids (the same as the default).

Sometimes, a neater way is to not give the other spouse (John Powell) their own box, but show that Lucy 
was either a widow or, or remarried to, someone else. To do this, select the spouse of the main ancestor on 
the chart, in this case, Lucy Evans. Make a note of the family number for the other spouse in question (in 
the example above, F5). Then from the “Chart Properties” panel, select the “Person” tab, and use the “…” 
button to the right of the “Fold wid/remarried” text box. This will allow you to select which family to fold.





This would then fold John Powell into Lucy’s entry, and state that she was either his widow, or remarried to 
(depending on what order her family with John Powell is in her record):



Text instead of kids
It is possible to stop a chart from the drop line of a parents. To do this, select the family from which you 
wish to show the text, and enter chart editing mode. From the “Chart Properties” panel, select the “Family” 
tab, then the “Text instead of kids” text box.

Text entered here will be shown instead of the children of this family



From arrow at top of chart
If some text, with an arrow is wanted at the top of a chart, for example to indicate that the information 
continues from another chart, this can be entered in the “From Arrow text” text box of the “General” tab of 
the “Advanced Parameters” section of the  “Chart Properties” panel.



Direct line only
On occasions, it is clearer to only include a direct line chart, that is, the family from a particular ancestor to 
one of their descendants, ignore all of the brothers and sisters of the ancestors at each generations.

This is easy to achieve with Pedigree Forge. First, start a new descendant chart from the ancestor as usual.

Find the ID of the descendant to whom you wish to show the direct line only. This usually will start with the 
letter “I” and is shown on charts.

In the following example, we created a descendant chart starting with James Griggs (I13), and want to 
create a direct line chart to the client (I1)



Select the “General” tab of the “Chart Properties” panel. Open the “Advanced Parameters” section by 
clicking on the arrow, and then and click on the “…” button to the right of the “Direct to” text box. Another 
dialog will popup to allow you to select the person to show directly to. 

Enter the destination descendants ID number (in this case, I1), and click enter. The chart will update to show
only the direct line between the two:

use the usual
default width and
position functions

to improve
the appearance

(right:)



Family symbols: divorced/never married
By default, a couple are shown with an “=” symbol between them:

If it is known that a couple never married, then the “X” symbol can be used. To do this, the person’s data 
must be edited in the main database. 

Make sure that one of the couple is the selected person, and that their correct spouse is shown if there is 
more than one. In this case, John Smith is selected, as is his spouse, Mary Jones.

Then change the “Status” drop down box to “Never Married”. The family symbol on the chart will change to 
an “X”.

This might not always be appropriate, particularly with modern families. So rather than selecting “Never 
Married”, “Cohabiting” can be selected. This will show the “=” symbol is usual, but the key will be updated 
to indicate that the “=” symbol is also used for non-married couples.



A divorced symbol “=” with a bar through it, can also be shown. To do this, the couple have to have a 
divorce fact in their family. To do this, make sure that the correct person and spouse are selected, then 
select “Facts” from the menu bar, then “Add Couple fact” and “Divorce” from the sub menus. 

This can be removed by deleting the divorce fact from the fact grid. The same process, and symbol is used 
for an annulment. 



Uncertain information—relationships
On occasions, it might be desirable to show on a chart a child-parent relationship that is plausible, but 
unproven. This is often shown with a dashed, rather than a solid line. To do this, make sure the active 
person is the child in the relationship. Then click on the  button next to the person’s name on the person ⋮
editing panel. Then set the “Certainty” value in the “Family As Child” section of the dialog box that appears. 

The values “challenged”, “possible”, or “probable”, will cause the line to their parents to be dashed, as per 
the example below, and a relevant entry added to the charts key.



Setting the “Certainty” drop down box back to empty will clear the line. If multiple siblings are set as 
uncertain, then the lines should update correctly.



Uncertain information—facts
On occasions, one or more facts in someone’s life might be unproven. For example, perhaps a death/burial 
has been found, but it isn’t yet proven that it is the correct one. The convention here is to show the entry 
on a family chart with a question mark. 

Facts can be flagged as uncertain by selecting them in the fact grid (whilst the correct person is selected), 
then using the Likelihood drop down box. Values of “possibly” or “probably” will cause a question mark to 
appear on the chart. Setting the box as empty won’t show a question mark.



Killed in action/executed, rather than died
By default, if a death fact is in the database, it will be shown on a chart as “died” or “d.” depending on the 
style of the chart. Sometimes, it might be preferable to show “Killed in action”, or use a different verb.

Ensure that the person is selected, and then locate the death fact from the fact grid. Use the “Type” box to 
choose a different kind, such as “Killed in action”

Not all types here will change the text on the chat, but many will. 

Stillborn children
The following is a sensitive issue, and different people will have different views, but it is perhaps more 
appropriate to show stillborn children on a family chart as stillborn, rather than giving them birth and death 
date. To do this, first ensure that the child is selected, then locate (or add) a birth fact to their fact grid. The 
set the “Type” drop down box to “Stillborn” and the chart will be updated accordingly.



Died without issue (dsp) and never married.
It is quite common on old charts to indicate that someone died without children, (using the Latin 
abbreviation dsp), or that they never married. Both pieces of information can be set in the database, so that
they will show on the chart. Both set up in a similar way.

Died without issue

Ensure that the relevant person is selected, then use the “hamburger” button to the right of their name box
to selected the “Person Extra Information”. In the “Children count” box, enter “0” and press enter, the chart 
will be updated as appropriate

Never married

Ensure that the relevant person is selected, then use the “hamburger” button to the right of their name box
to selected the “Person Extra Information”. In the “Marriages count” box, enter “0” and press enter, the 
chart will be updated as appropriate



Twins/multiple births
It is conventional that twins/triplets etc. are shown on a family chart with a common line, grouping them 
from the other siblings. This is done automatically if two children are given the same date of birth, and are 
next to one another in order in their family. 

See the section on editing twins and multiple births in the section on working with people in this guide for 
more advanced scenarios. 



Chart styles
Pedigree Forge comes with a number of pre-defined chart “styles”, the term style being used to describe 
things like font, colours and text formatting. There are also different chart “modes” which are used to 
describe how a chart is built.

Chart styles are set from the “Style” drop-down box of the “Style” tab of the “Chart Properties” panel, 
whilst editing a chart:

The default style is “calligrapher” which is what we have used in our examples so far. 

A few of the other styles are described and illustrated below:

Antiquarian
Inspired by some of the charts often presented with family history books, with a “wordy” style, no colour, 
and justified text:

Visitation

Similar to Antiquarian, but with an Old English Font title, as often used in printed “Visitations”:



Celtic
A chart with a celtic inspired font:

Monastic

A whimsical style inspired by monastic writing:

Minimalist

A more modern and plain style with a clear san-serif font:

Other styles are likely to be added in the future.



Tinctures

In addition to various styles, a set of “tinctures” can also be used to change certain colours used in many of 
the styles. Tincture is the term used in heraldry to describe colours used in coats of arms, and that tradition 
is carried forward using the historic names for these, as follows:

Or: Gold (Metal)
Argent: Silver (Metal)
Azure: Blue
Gules: Red
Purpure: Purple
Sable: Black
Vert: Green

Also included are the “stains”:
Sanguine: Blood red
Tenné: Tawny
Murrey: Mulberry



Custom chart styles

If the built in chart styles don’t fit you needs, it is possible to create your own styles, using fonts and colours 
of your choosing.

First, ensure that the chart style is set to “custom”, on the “Style” tab of the “Chart Properties” panel:

The “Style” section tab can then be used to choose fonts, sizes and colours, for various chart features:



Clicking on the font names will show the system font dialog to allow you to choose a font:

Clicking on one of the coloured squares will show the system colour dialog, to allow you to choose the 
colour:



Birth brief charts
Pedigree Forge allows you to create “Birth brief” mode charts. These start from a particular person, and 
present their ancestors horizontally, with a summary of information of their direct ancestors. They are a 
good way to get an at a glance view of all ancestors, back to the great, great, great grandparents:

To create a birth brief style chart, click on the “New Chart” button, located on the Charts tab, and then 
select “Birth Brief”

You will be prompted to select the starting person, and then the chart will be created.

Editing birth brief charts is similar to drop-line charts, as already described, in that the information is 
entered via the “Chart Properties” panel, whilst in editing mode. However, many of the options aren’t 
applicable in this fixed sized chart.



Although birth brief charts always start from a single person, you can opt to show their full siblings on the 
chart too. To do this, ensure that the chart is in “editing” mode, then check or uncheck the “Siblings on birth
brief” check box, which is in the “Advanced Parameters” section, on the “General” tab of the “Chart 
Properties” panel:

Whilst “Default row height” usually has no effect in birth brief mode, as it is a fixed layout, if the starting 
person’s siblings are being included, then the “Default row height” value can be changed to effect the 
spacing of the siblings:



Ancestor charts
Pedigree Forge can work with charts that start with a particular person and shows their ancestors. This is 
the reverse of a  drop-line descendant chart, which starts with one or more person and works forward.

To create an ancestor chart, click on the “New Chart” button located on the “Charts” tab, and then select 
“Ancestor Chart” from the drop-down menu:

You will then be prompted to select the starting person and the ancestor chart will be created:

In the above example, William Erasmus Darwin was selected as the starting person, and the chart shows all 
ancestors entered for him. 



Editing ancestor charts is very similar to editing descendant charts, although as the chart is set out from the 
ancestor at the bottom, and only ancestors are shown, not all customisations work. In particular multiple 
marriages aren’t shown (only the one from which the starting person is descended) are included.

Ancestor charts don’t show siblings either: they only show the ancestors. Including siblings of each 
generation as you work back would create a spiders web mess.



Hybrid charts (descendant and ancestor mixed mode)
Pedigree forge allows you to create a hybrid chart, which starts from a particular person and includes their 
descendants and ancestors: it is a mix between a descendant chart and an ancestor chart. There is also the 
option to include their siblings too (and their descendants too). 

To create a hybrid chart, click on the “New Chart” button on the “Charts” tab, then either select “Hybrid 
Chart” if you want to start with a particular person, but not include their siblings or “Hybrid With Siblings 
Chart” if you want to include their siblings too:

The following is a “Hybrid With Siblings” chart, start with Charles Robert Darwin. It includes his ancestors, 
and descendants. If further generations were added, the chart would expand. 

A Hybrid chart (without siblings) starting with Charles wouldn’t include his siblings (or their descendants if 
added).

Editing hybrid charts is very similar to the steps outlined for drop line charts, indeed, some of the chart is a 
drop line pedigree. 

A similar effect can be created by specifying multiple start people on drop line pedigree charts, see the 
section on “Starting charts with multiple people”. The main difference is that the hybrid mode charts don’t 



include siblings of ancestors of the starting person, which often gives a “cleaner” looking chart, at the 
expense of some information. 

Printing and exporting charts
Charts can be printed or exported to other file formats (including PDF), via the buttons along the top of the 
Charts tab, or from the “File” menu. 

Supported formats for export:

PDF: “Portable Document Format” recommended for most uses.

SVG: “Scaled Vector Graphics”—useful for various tasks, such as including on website. Important SVG charts
require the same fonts to be installed on the viewer’s machine. Some of the fonts used in Pedigree Forge’s 
standard charts aren’t installed by default on many computers.

PNG, JPG, GIF, BMP: rasterised formats. 

HTML: SVG (see above) embedded into an HTML document—experimental use for creating accessible 
charts for visually impaired users. 



Working with sources
Recording how you know something to be true in genealogy is very important. Many genealogists regret not
doing so too late!

Sources in Pedigree Forge are entered and edited via the source editing panel, which can be accessed from 
the second button on the “Action Bar”, which runs down the left-hand side of Pedigree Forge’s main 
window:

At the top of the sources panel is a table showing all sources so far entered in the project (the list above is 
empty). Clicking on one of the sources will make it the active source and allow you to enter or edit details. 
The buttons along the top of the table allow you to add, delete, or change the order of sources. 

Creating a source
At the simplest level, you can click on the “+” button to create a new source, this will add a source and you 
can start entering information in the fields below:



Some of the fields lower down the sources panel aren’t shown by default, but can be made visible by 
clicking on the “>” buttons to show the extra fields:

The amount of detail you record for each source will vary depending on your tastes. At a minimum, you 
would probably want to give a source a title, record the “archive” in which it was found and some kind of 
reference number, which will depend on the convention for the source.

Below is an example of how we might enter the information about Charles Darwin’s death certificate:



As the death certificate is registered as Charles Robert Darwin, that is the title used. The “Archive” is the 
General Register Office, and the “Call No:” is the reference. In this case, this is how the General Register 
Office reference particular certificates via their indexing system. 

The “Archive” is set by clicking on the “monument” button, which will pop-up a dialog allowing you to select
an archive from a list.  

When you start your project, only a small number of archives are pre-populated. You can add new ones via 
the “< Add New” button in the lower-right hand corner of the “Select Archive” dialog:



Archives can also be added and edited separately on their own editing panel. More information can be 
found in the archives section.

Sources are most useful when they are linked to from facts and events. This creates a citation, i.e. so we 
know the source of the information in that fact or event. 

Citations
Pedigree Forge supports two types of citations. Firstly, there are citations that are linked to a source. To link 
a source citation to a fact, locate the relevant fact in the “Facts and Events” table for the relevant person (or 
one of the couple if it is a couple fact). Click on the fact so that the fact is the current one being edited (its 
information will appear in the fields below the table):



Then, either click on the “+” button below the “Citations:” label, or right-click on the fact in the table and 
then select “Add source citation” from the pop-up menu.

This will pop-up a dialog to allow you to select the source to link to. By default, the source being edited will 
be selected. Clicking the “OK” button will link the fact to the source, creating the citation.

The source will show as linked in the “Citations:” list: 



Citations can be edited using the “+” and “Trash” buttons to the left of the citations list. More options are 
also available by right-clicking on the citations list, which will show a pop-up menu of choices:

Local Citations
In addition to citations that are linked to a source, it is also possible to create local citations. These are more
“light-weight”, than a complete source citation. Perhaps little more than a footnote. I often use these where
the only reference is from an index (such as the GRO index of births/deaths/marriage), rather than a full 
document. 

Clicking on the “Add local” option above (or using the “+” button and then selecting the local option). Will 
show the Local Citation dialog:

You can enter free-text in the box at the top of the dialog, then select “Ok” to add the text as a local 
citation.

The tabs below, such as “GRO” and “Scots” will help you formulate an entry: 



When the details have been entered, clicking “Build” will show the text in the box above:

Clicking on the “Ok” button will then add the local citation to the selected fact:



Source images
In the following example, we will build on Charles Robert Darwin’s death. Below is the image of the entry 
obtained from the General Register Office:

Source images should be downloaded or placed in the same folder as the file in which you are working. 

Make sure that the “Media” section of the source edit panel is showing (use the “>” button to open it if it 
isn’t). The click on the “+” button. You can either add a local image, or link to one already in the gallery. 

In this example, we will use a “Local image”, i.e. one that will be local to this source.

The “Media Picker” dialog will appear, showing the images in the project’s directory. Select the relevant one
and click “Ok”:



The image will now be linked to the current source:

Multiple files can be added, if the particular source spans more than one page.

The image linked to the source can now be viewed within Pedigree Forge, on the “Source” tab:

The toolbar that runs along the top of the Source tab can be used to undertake various tasks, such as 
zooming in/out or moving to different images if there is more than one image for the source.

It is also possible to “Draw Paths” on top of the image. These don’t effect the original image, and only 
appear in Pedigree Forge or report outputs. You might, for example, want to highlight a particular entry on a
census, as shown below:

Selecting “None” from the Draw Path box allows you to “grab” a large source image with the mouse and 
move to different sections. “Clear paths” clears all paths on the current image.



Source image editor

Pedigree Forge includes a basic image editor, designed to help with some of the tasks you might want to do 
with source document images, like cropping. This can be accessed either from the Edit Image icon button on
the sources tab toolbar, or from the Media grid on the sources panel:

The “Image Editing Dialog” will then appear, showing the current image. 

If you edit an image (by cropping it), you are likely to have to change and “paths” drawn over the image, as 
they are placed based on the images size.



Source transcripts
Recording the basic information about a source (title/archive/call number) is the first step to properly 
organising your research. The next step is creating transcripts, or capturing information about a source. This 
was once very important, as the documents were always hard to access, and often it would be impossible to
get an image of the source. In today’s world, where many sources are available online, it is still a great way 
to make sure you have understood all the information on the source, and make it available to your family, 
who might not be able to read the old-handwriting.

Source Text can be entered in the relevant section on the sources panel:

The source text can accept “Rich text”, such as bold, italic, tables etc. To access these features, click on the 
pencil icon above the Source Text entry box, which will show a fuller text editor—see section on Rich Text 
Editor for more information:

Many standard sources used in genealogy use common forms, for example, censuses, birth/death/marriage 
certificates and even later parish registers. You can create tables for these in the Rich Text Editor, but there 
is a simpler way to enter this kind of information, as Pedigree Forge comes with many built in source 
templates. For Charles Darwin’s death certificate, we can set the “Template:” to “DEAT1837”, selected from 
the dropdown list



Now, when the pencil icon button is clicked, a template based on the General Register Office’s death 
certificates, introduced in 1837, will be shown, allowing the information to be entered in a tabular format:

Note: we leave the top section blank in this case, as the image we have is the digital copy provided by the 
GRO, whereas the other information is if it were from a death certificate:

Clicking the “Close” button saves the transcript.

The benefit of transcribing sources in this way is that they can be included in reports. Below is how the 
transcript would appear in our report (see the section on Reporting for more information).



More source transcripts
Pedigree Forge includes a large, and growing, number of pre-defined forms for transcriptions. Many of 
these take a tabular form, like census transcripts.

Some fields are suggested for you, based on common values. For example, “Scholar” is a value that 
commonly occurs in this field on census returns, and so is suggested as you start to type:

Pressing the [Enter] key will accept the suggestion, or pressing the [Esc] key, or continuing to type will allow 
you to enter your own value.

Spell checks are made in the transcript forms as the detail is typed. If there are spellings that are in the 
original, but aren’t “correct”, we can flag them as ignored, and they are showed as underlined in magenta—
see the section on spell checking for how this feature works. 

When working with censuses, information is often the same in one row as it is for the cell in the row above. 
In the example shown here, William Dryland was also born in Sellindge. Pressing the [Ctrl] and [D] keys 
copies the value from the cell above:

The transcript forms are “modal”, that is, whilst they are open, you can’t interact with the Pedigree Forge 
main window directly. However, some shortcut keys allow some of the most likely tasks you would need to 
do on the main window, without closing the transcript dialog:

[Alt] + [arrow keys]: Moves the chart canvas window view point, i.e. the background image being 
transcribed is moved left, right, up or down, relative to the transcript window.

[Ctrl] + [arrow keys]: Moves the transcript window (leaving the background image in the same place). This 
can also be achieved by clicking on the grey areas of the transcript dialog and dragging.

[Page up] or [Page down]: If the source contains multiple images, these keys will move to the next or 
previous source image. 

[Esc] Closes the transcript dialog.



It is possible to make the source transcription window semi-transparent. This is useful if screen space is at a 
premium, as it allows the text below the dialog to be partially visible through the window itself. To enable 
this, click on the small arrow next to the source transcript dialog’s title and select “Toggle Transparent”: 

Markdown in source transcript fields
In most cases, the transcript forms used contain ordinary text. However, on some occasions, there might be 
features of the text that benefit from limited styling, for example strike out. It is possible to enable a limited 
“markdown” like formatting of text in transcript fields. This feature has to be enabled for the project, via the
“Project Settings” panel, which can be accessed from the cog button, located towards to lower-left corner of
the Pedigree Forge main window:

The “markdown” format is similar to that used on mobile apps like WhatsApp, and also used by many 
programmers for documentation. 

When this is enabled, the following formatting is applied:

Feature Example Styled as
Strike out This is ~struck out~ text. This is struck out text.
Bold This is *bold* text This is bold text
Italic This is _italic_ text This is italic text
Underlined This is __underlined__ text. This is underlined text.
Superscript This is ^superscript^ text. This is superscript text.
Larger/smaller text This is \+ larger \- text. This is larger text.
Small-caps This is $Small Caps$ text. This is SMALL CAPS text.
Number width space \# (Space the width of digits, 0 to 9)
Non-breaking white space \~ (Space that doesn’t break lines)
Fill gap with dots \>. …………………………………….



Fill gap with under bar \>_ _____________________________
Fill gap with wide dots \>* . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Fill gap with space Left\>>Right Left                                     Right
To next tab stop \>

An example where this feature might be useful is the 1939 register, which often included later annotations 
showing married names. It is useful in the transcript to see what was original, and what was added later.

If you need to use one of the “markdown” symbols as a literal character, with markdown enabled, then 
typing two together. For example, if you want a literal * rather than starting bold, ** will output a single *, 
or if you need a literal \ you will have to type \\. If the markdown feature isn’t enabled, then you don’t need
to double up on the characters. 

In the following example, Eileen and Joan have married after the 1939 register was taken. We use the strike 
out (~) and superscript (^) markdown to reflect the original as best as possible:

When a report is created, and with the markdown feature enabled, the transcript is rendered as follows:



Working efficiently with sources
Pedigree Forge includes a number of features that make working with sources very efficient. To get the best 
from using sources in Pedigree Forge, we have to reverse our thinking: rather than adding the fact then 
finding the source, we should add the source, then create the fact. This is the  more natural way to do 
things when researching properly, and the approach that Pedigree Forge gives most assistance. 

The following will walk through the same source (Charles Darwin’s death) as shown in the working with 
sources section, but taking the “Source first” approach. 

First, we use the built-in web browser to locate the source, in this case, we have used the General Register 
Office’s site: www.gro.gov.uk. To open the web browser, click on the “+” button on the tabs:

A new browser tab will appear, initially showing a home page. This works like any other web browser, and 
you can enter the address manually. The General Register Office’s site is one of the default bookmarks, and 
so we can click on that to open their website:

Using their website to locate, purchase and down load the image is beyond the scope of this guide, but you 
should download the file to the same folder in which your project is located. 

Pedigree Forge will recognise that a new file has been downloaded to the project’s directory, and the “File 
Watcher” dialog will pop-up automatically, showing the file:

 

http://www.gro.gov.uk/


A number of options can be carried out on images in the file watcher, and can be accessed either from the 
buttons that run along the bottom of the dialog, or by right-clicking a file in the list, which shows a pop-up 
menu:

If we select “Make Source”, a new source will be created with the image already linked in and the edit 
source panel will be shown, ready for you to enter the details. Below we have added the title, linked the 
archive and set the call number. We have also selected the “Template” as “DEAT1837” (which populates the 
“Fact” type to “DEAT” automatically). Note: Pedigree Forge uses OCR (Optical Character Recognition) to try 
and populate the template and fact fields based on the source image, but this isn’t an infallible process, and
will sometimes need entering manually. 

In addition, we are also going to enter the “Date” and “Place” fields this time too. In this particular case, no 
address is shown (see information on entering dates, places and addresses, elsewhere in the guide).



We can then transcribe the document, if we wish (see Source Transcripts section).

We are now ready to link the source. Navigate to Charles’ record so that he is shown as the active person in 
the edit person panel. However, remember we are working in reverse; there isn’t yet a death fact for 
Charles—we are going to create the fact from the source instead. 

On the “Facts and Events” table, click the magic wand button.

The “Select Source” dialog will then appear to enable you to select the source to import to the fact. By 
default, this is the source you were most recently working with:

Clicking the “OK” button with the correct source will then import the source, creating the death fact, which 
already contains the date, place and a citation to the source:

You can add extra information, for example, age and cause, if applicable.



Sometimes, the creating a source from a fact will fail, and you will get an error message such as this:

If that happens, it might be because a fact of that type already exists (for example, if we tried to import the 
death again, it would fail).

A fact also can’t be imported if no “Fact” type has been set for it, or if there is no date. These are set on the 
source edit panel:



Create children from census transcripts
To help efficiently working with sources, Pedigree Forge has the ability to help you add children from a 
census transcript. The extra time it might take to transcribe the census form is therefore saved by creating 
the children automatically.

In the following example, we have created a source from the 1861 census for “Down House”, in Down, Kent,
where Charles and Emma were living with their children. Only the family members have been transcribed: 
there were many servants and visitors too.

Link the source to Charles and Emma, as described already and make sure either Charles or Emma are the 
active person, showing in the person edit panel. Currently only one child has been added for them: William, 
born 1839. Click on the person in house icon button, located above the Children Table:

This will show the
“Census Children Dialog”, which should extract the children’s names from the census transcript we have just
made: 



The list of the current children is shown on the left of the dialog. Use the “Add” check boxes to decide which
children should be added. As William is already a child, we should uncheck him (we don’t want to create 
him again). 

Notice how the places are shown in red. This is because they haven’t been recognised, coming straight from
the census transcript (it does expand “Do” i.e. ditto marks from lines above). Below we have changed 
Henrietta’s entry to “Down, Kent”, which is recognised:

The other children need the place of birth changing too. You can do this manually, or, if you press “Ctrl” + 
“D” on the keyboard, the details from the box above will be copied down. 

You are then ready to apply the changes. Clicking the “Apply” button will add the children, along with their 
specified place of birth, and an estimated year of birth, based on their age:

Note: the add children from census dialog should be seen as an aid. It will need manually alteration, and 
checking that information it suggests is as expected.



Archives
The term “Archive” is used in Pedigree Forge to indicate somewhere that keeps source documents.  This 
might range from a large institution, like the National Archives in Kew, or your own person box of papers 
passed down through the family. 

Archives can either be added “on the fly”, from the “Select Archive” dialog, as shown in the section on 
working with sources, or from their own editing panel. The archive editing panel is accessed from the 
“museum” icon, located on the main action bar that runs down the left-hand side Pedigree Forge’s main 
window:

Selecting the archives panel will show a table at the top of the archives already in the project. Clicking on 
one of these will make it the selected archive, so its information can be added. The buttons in the top-right 
hand side of the table can be used to add or delete an archive:



For most archives, only the “Name” is needed.

The use of brackets in the name is important: the text inside is used as the short abbreviation in reports. So,
for example, “General Register Office (GRO)” will be abbreviated to GRO when it is used more than once in 
report citations. 



Sources – how source was accessed
In genealogy, we often record both the original source location, and where we viewed it. The original source
location (archive and call number) is most important, as it would allow someone else to view the source if 
they wished to. In the following example (1861 census for Down House), the original is located at the 
National Archives, and has the call number “RG9/462 folio: 74 page: 10”:

In our particular case, we accessed this via the website, www.findmypast.co.uk. Best practice is also to 
record this information. For this, we can use the “Via” field, located below the call number. Text can either 
be entered free-form, or the “Tag” button can be used to access a dialog to help:

There are various pre-populated drop-down lists, which can be selected, and then the “Build” button used 
to build the sentence, including the date. The “Ok” button applies the information:

http://www.findmypast.co.uk/


Source groups
Sources allow a “Group” name to be entered. If we were researching many different branches of our family, 
we might want to group sources by surname. Group names can be entered in the “Group” field of the 
source panel, and are shown in the Sources table too:

Source groups are most useful when creating reports, as you might want to only include sources from a 
particular group with a given report. 

Source backlinks
It is possible to see who is linked to a source via citations. This can be done from the “Backlinks” section on 
the source panel:

Click on the “>” button next to the Backlinks, if it isn’t showing. If you have a large database, showing back 
links can be slow, so these aren’t shown by default—click the check box so they are visible. You can also 
select the person from the backlinks list and use the “→]” button to go to the fact in the person’s main 
record. 



Sources – published books etc. 
By default, the source editing information is arrange to record “manuscript” type sources, i.e. those that 
exist in original form, often in an archive. It is always advised to check these “original” documents (or 
surrogates) where possible. However, sometimes the only source might be published information. Perhaps 
you can’t access the original, or it might have even been destroyed and so information published whilst the 
original still existed is the only source. 

Published sources such as this are better described with an author and date of publication, rather than an 
archive and call number. This can be entered in the “More Options” section of the source panel. If the fields 
aren’t showing, you may need to click on the “>” button to show the fields:

The “Published” field would normally be the place and year of publication. 

Sources – abbreviation
The “Abbr.:” field on the “More Options” section of the Source Dialog can be used to provide an 
abbreviated, or “Short” title for a source. 

The abbreviation field can also be used to give an alternative title. For example, if you created a source that 
is based on the extracts from a parish register of all the children baptised to a couple, you might give the 
main title as “Extracts of Baptisms for the Children of John and Jane Smith, Middleton, Register of Baptisms 
1813-1842”, you could then use “Middleton Register of Baptisms 1813-1842” as the abbreviated title. 



Reports
Pedigree Forge is very flexible when it comes to creating reports. You can create a basic report with just a 
few clicks, but there are many ways that reports can be customised. 

Reports are accessed from the report panel, which can be accessed by clicking on the book icon on the left-
hand action bar. 

Each project can have any number of reports, and each report can include any number of “items”, the 
components that make the report. 

Reports can be viewed inside Pedigree Forge using the “Report” tab. Note, for any changes to be seen the 
report, must be updated using the refresh button:



Reports can be printed, or exported (for example as a PDF), from Pedigree Forge using “File” from the main 
menu bar:



Create a report
The quickest way to create a report is by using the “+” button on the reporting tab. This will show a popup 
menu of the available report types. Select “Standard Report”.

This will create a standard report with a number of items within it. The aspects of the report, such as title, 
and theme (the font used), can be changed as required. 



The report as created, is linked to a note (id N1) and a person . These can be changed by double-clicking on 
them. 

Items can be added, re-ordered, or removed from the report using the small buttons in the top-right corner 
of the report items grid.

Don’t forget to press the “Refresh” button on the report view so that you can see the report and after any 
changes made. 



Items in reports

AncestorChapters
This automatically creates chapters for all ancestors of the person selected. The person themselves doesn’t 
have a chapter (they are included in their parents chapter). 

Each chapter is grouped as an ancestral couple, and includes the information entered about them in the 
databased, as well as a list of their children. Other spouses are also included. 

As one of the most important components of a report, Ancestor Chapters can be heavily customised, but 
the default configuration will be fine in most circumstances. 

Below are a couple of example pages from an ancestor chapter within a project that has many citations. 





In addition to the text automatically generated for each ancestor, manual text can also be included. This is 
added after their introductory paragraph. Text to appear here is written in the “Notes” section of the person
edit dialog, specifying “Report Notes” as the type of note. 

Clicking on the pencil items next to the “Report Notes” drop down allows the text to be edited in a separate
window, which also allows formatting of text—see section on the rich text editor for more information. 



Pictures can be included in Ancestor Chapters if they are linked to the person in their record (use the 
“Media” section on the person panel:)

FamilyChapter

Creates a chapter for a particular couple, similar to the AncestorChapters, but does not follow them 
backward.



PersonChapter

Creates a chapter for a particular person, similar to the AncestorChapters, but does not follow them 
backward.



NoteLink

Perhaps more of a consideration for professionals genealogist, who want to write a research report, the 
NoteLink item allows a large amount of text to be entered that isn’t linked to any particular person. It is a 
mini word processor within Pedigree Forge. See “Rich Text Editor”.

Notes are added using the pen icon from the action bar on the left of the Pedigree Forge window. They are 
edited (and can be added or deleted) from their own window. The ID number is used to link a NoteLink item
in a report, to a note record. It is also possible to give a particular note record a name, so it can be located 
via name, rather than ID.



Sources

Outputs the sources in the project, along with any transcripts made. The information that appears here is 
entered in the “Sources” panel, accessed from the scrolled page icon on the main action bar: 





Sources might include a link to an image of the file for the source, and can also include transcripts made of 
the information it contains. Many pre-built templates for transcript forms are included. Below is an example
of a British 1881 census entry being edited using the 1881 census template and how it appears in the 
sources item in the report.

If there is no suitable template, text can also be transcribed manually using the word-processor like 
interface. See “Rich Text Editor”





Advanced Feature: If only some sources are required to be included in a report, editing the “Sources” 
report item will popup a dialog to select which source or sources should be included. They can either be 
selected by individually or by a group name.

Important: The source id numbers are the numbers that begin with an S. These are internal. When reports 
are created, sources are numbered from 1, in square brackets, according to the order they are presented in 
the report, surrounded in square brackets, for example [1]. This creates a professional cross-referencing 
systems. The numbers won’t necessarily match, i.e. source S1, won’t necessarily be source shown as [1] in 
the report. 



References

Outputs the sources used in a project, but in a summary form list only:





Chart and SingleChart

Pedigree Forge’s charts can be embedded into reports. The default “Chart” outputs a chart that spans 
across two adjacent pages. A SingleChart outputs a chart that is on a single page in a report.

Double clicking on a Chart or SingleChart item in the list opens the Edit Family Chart dialog: see Creating 
Family Charts. Embedded charts can also be edited by clicking on the chart icon on the report panel, or the 
chart icon in the report viewer (assuming that there is an embedded chart on the selected page).

When including embedded charts that span two pages, you are likely want to avoid the middle of the page. 
This can be achieved by clicking the “avoid middle” check box when editing the chart:



Getting a beautiful chart that is still well balanced and avoids the middle of the page is a bit tricky and takes 
practice! 

TOC

Outputs the table of contents

Index
An index of the people who appear in the report.

Chapter

Outputs a chapter heading, and starts a new chapter. The chapter’s title can be set by double clicking on the
item in the report list, which will open a small dialog to enter/edit the text:



ChapterNotInTOC

A chapter heading but which isn’t included in the table of contents. See Chapter above.

Part
Sets a part title, for major parts of a report. 



Image or ImageInGallery

Includes an image in the report which isn’t associated with a person or a source. Double click on the item in 
the Report Item grid to select the image file (must be in same folder as the project). You can also set the 
caption from the dialog that appears. The ImageInGallery links to an image already in the media gallery. 



Configuring Reports
One of the items available in the report items list is the configure report item. This is an advanced feature, 
but allows changes to be made to how a report is created. The configuration item must be the first item in 
the list of items for it to have an effect throughout the whole report. 

Configuration options are edited by double clicking on the “Config” item in the list of report items:

There are various lists on this dialog. Using the “+” and “trash” buttons will allow you to select certain 
records (generally people), to configure the report. 

Don’t create chapter for: don’t generate a chapter for the person(s) in the list and don’t follow them back 
either.

Ghost from chapter: In the chapter in which this person would appear with their spouse, create a chapter 
but ghost this person from it (don’t them in the title or narratives). Useful if there is reason that this person 
should be virtually ignored. 

Half ghost from chapter: In the chapter in which this person would appear with their spouse, create a 
chapter and include that person in the chapter title, but don’t write a narrative for them. Useful if the 
person isn’t of interest in the report.

No media in chapter: doesn’t include any media (attached files) for this person or these persons. 



Reverse in chapter: If there is a husband and wife, normally an AncestorChapter starts with the husband. 
Selecting one of the people in a chapter here starts the chapter the other way round. This means the wife is
introduced first and appears first in the chapter’s title. 

Reverse joint marriage: Switch the order in which spouses are introduced in the narrative in the marriage 
clause paragraph. The chapter headings are left in the default order. 

Stop at children: when people are included in child lists, stop at this person, don’t include their own 
children in the subordinate list.

Local source citations in reference list: When checked, includes local citations (those without a source 
record) in the references report item, otherwise exclude them. 

Use UPPERCASE surnames: It is recommended that surnames are entered in their natural case, usually with
a capital letter first. Pedigree Forge leaves names as entered, because sometimes case is relevant, including 
inside a word, for example “McNelly.” There is an old-fashioned convention of using uppercase for 
surnames. Checking this box will force surnames to always be upper case. 

Custom chapter tiles: Change the default title for a particular person or family’s chapter. Select a person or 
family, and use the dialog box to set what the chapter title should be.

Which parents for adoptees: When building the ancestors to be included in a report, this sets which family 
or families, and in what order, the parent families should be followed. Select the person and the family 
combination. 



Rich Text Editor
There are several places where styled text (bold, italic, sub-sections etc) can be entered. This amounts to a 
mini word processor within Pedigree Forge. This text can then be shown properly styled in reports. 

The main places where rich text can be added are as follows:

Project Notes—Accessed using the “pen” icon on the main action bar. These can form text in a report that 
isn’t tied to a particular person.

Person Notes—Accessed from the “Notes” section on the person panel. There are two types of notes here: 
Biographical Information, which is shown in the a report where that person is included or Research Notes, 
which isn’t shown in any report.

Source Text/Notes—Accessed from the source panel in the “Text:” or “Note” box. These are output in 
reports in which the relevant source is included.

Editing rich text is these places includes a similar toolbar, which should be familiar to word processor users: 

Most of the buttons act like toggles: selecting bold text and then clicking the Bold button which toggle off 
the bold attribute.

The top row includes: undo, redo, text size, bold, italic, underline, strikeout, superscript, subscript, small 
capitals and highlight. Examples are below:

The second row includes: tables, numbered list, bullet list, block quote, heading level 1 (Section), Heading 
level 2 (Sub section), Heading level 3 (sub sub section), links, align left, align centre, align right and justify.



Note: The font face cannot be changed. This is set at the level of the report itself.

The link button allows various special features to be added: 

Source Citation Footnote
This allows a source to be selected, which shows in the word processor as a superscript reference to the 
source. In a report, this is shown as a footnote referencing the source.



Source Citation Brackets
This allows a source to be selected, which is shown in the word processor in brackets (to the source ID), and
is output in the report as a reference to the correct source.

Person Index Entry
Outputs a mark that isn’t visible in the body of the report itself, but adds an entry to the index of the report 
for the selected person. Index entries are automatically created for where people appear in Ancestor 
Chapters, so this is mainly useful in project level notes.

Hyperlink
Allows you to enter a hyperlink to a website. 

Manual footnote
Manual footnotes allow text to be entered as a footnote that isn’t linked to a source citation. 



Place
Allows a place to be selected from the places used in the database. Note: when expanded in a report, the 
long form of the name is used first time in the chapter in which it occurs; subsequent uses will use a shorter
form. 

The above example would show in the report as: “The client’s father was born in Southampton, Hampshire, 
on 8 July 1918, and lived in Southampton all his life”.

Tables
Tables can be added using the table button from the rich text editor’s menu bar. They can be added by right-
clicking with the mouse whist inside the table:

The “Borders” option, toggles if the borders will be drawn any output report. The table below has had its 
borders turned off, so they are shown in light-grey in the word processor, and won’t appear at all a report. 

Table columns can be made larger or smaller by clicking on them and dragging. Note: Tables are always 
shown in reports as the full width available to them. The widths of columns assigned is relative to the width 
set in the word processor. In the example below, the Number column would be approximately 20% of the 
width available, and the other two columns 40% each:



Auditing and validation
Working with data in a family history database can introduce errors. Pedigree Forge supports both real time
warnings and also has an audit report, which can help to find and correct errors too. 

As you navigate around  the people in your file, some possible errors will be checked in real-time and show
in the status bar. This are for the current person in the edit panel:

In  the  above  example,  Pedigree  Forge  has  noted  that  the  children  of  the  current  family  aren’t  in
chronological order. You can then use the children table to sort them chronologically.

Some of the warnings are things that might be errors, but can sometimes happen. It is rare to find children
born after a lady was in her mid-forties, but it does happen on occasions. Charles Darwin’s wife was 48
when their youngest son was born, as shown in the example below. If you click on the status bar warning,
you can select to ignore the warning for that person going forward. 



To run an audit over your the whole file, select “Audit and validation” from “Tools” on the menu bar.

This will add a tab to the list of content tabs, which are to the right of the editing panels:

At the simplest level, clicking on the “Refresh” button, on the Audit tab will run an audit of your file, with 
any warnings listed in the grid below. 

Not all warnings will be an error; some things happen rarely, and so are more likely to be an error, or least 
need a big more work before accepting that they are correct. 

The following audit has returned two warnings:

Double clicking on an item in the audit report list will take you to the correct record (and fact/event if 
applicable). 

If we right-click on an item in the list, we are presented with a few options:



The first item is a warning because Charles Waring Darwin was born in 1856, when his mother was 48. This 
is quite old for a woman to have had a child, but did really happen in this case. We can therefore select 
“Ignore always for this record”. This will stop the audit warning from appearing again.

The other item is an error in our file: 

Caroline Sarah (born 1800) is listed after her brother, Erasmus, who was born in 1804. We can therefore sort
the children, so they are in the correct order. 

If we then click the “Refresh” button again, the audit warning will disappear. 

If you have a large file, there might be too many warnings to process conveniently at once. In this case, you 
can use the filter options, to reduce the number of items records that are checked, and then do them in 
stages.

Clicking on the arrow next to “Filter Options” will show some boxes to allow customisation of who is 
included in an audit:

Use the “…” buttons to select a start and end (or one or the other) people to check. This is based on the 
order they appear in the lists when they appear (file order). You can also opt to see previously ignored 
warnings too. 



Queries
It is sometimes useful to run queries on the data in your project. Queries are accessed from the “Tools” 
menu.

When “Queries” is selected, a Query tab will be added to the tabs on of the main screen:

The particular query you wish to run can be selected from the “Query to run” drop-down list:

The data will then be presented in the table below:



Double clicking on an item in table will show the relevant record in the editing panels, usually located on 
the left-hand side of the screen.

Usually, the query grid will automatically update as any changes are made, but some queries might take a 
long time to run on large files, and so you can disable auto updates, and then use the “Refresh” button to 
update manually.

Some queries require extra parameters. For example, the “Matching User Tag” query requires you choose 
which user tag you want to show matches for (see “User tags” section” for more information). When this is 
the case, extra options will appear next to the query drop down. For example:



User tags
When you are working with data, you may have a need to set “tags” on certain people in your project. For 
example, you might want to flag that more work is needed on a particular person, or that they are a direct 
ancestor, a that you have a DNA match with them. To do this, you can create your own tags, for use as you 
wish.

Tags are entered from the project settings panel, accessed via the “Cog” icon button, located at the bottom 
of the action bar that runs down the left-hand side of the main screen:

User tag definitions are edited via the “User Tags” table on this panel, via the buttons at the top of the 
table: 

Adding or editing a tag will show the Edit user tags dialog, allowing you to enter the text for your tag, and 
set the colour:



A default colour is suggested, but double clicking on the coloured square will enable you to choose a 
different colour for this particular tag.

Tags are applied or removed from people via the normal person edit panel. Towards to bottom of the panel 
is the “Other Details” expanding panel (closed by default). Clicking on the button so the arrow points 
downwards will show the panel:

If you are working on a small screen, you may need to close the “Children” or “Facts and Events” panels so 
you have enough room on the computer screen. 

Clicking on the person tag button will show the user tags edit dialog, you can then select which tag (or tags) 
apply, and click on “OK” to confirm. 

The applicable tag(s) are then shown in the person’s edit panel:



Tags can also be configured to appear on charts. They are shown by default on the automatic dynamic 
chart: 

The tags aren’t shown by default on charts you create, but can be made visible by click on the “User tags” 
check box on the “Layout” tab of the “Chart Properties” panel—see section on Creating and Editing Charts:

 

You can also run queries to see which tags apply, see the section on Queries.



Web browser
Pedigree Forge includes an integrated web browser (Microsoft’s “Webview2” technology). You can disable 
the default browser if you wish—select “Options” from the “Tools” menu. The on the “Options” dialog 
uncheck the “Use embedded browser” check box on the “Internet” tab. You can also set the home page 
here too.

To open a new browser tab in Pedigree Forge, use the “+” button along the top of the tabs:

A new browser tab will open, initially on the home page (this can be set from the Options dialog, accessed 
from the “Options” item on the “Tools” menu.

The browser works like external web browsers, allowing you to surf the web. Some common genealogy links
are included along top of the browser tab. These can be customised (see section on bookmarks):

Browser tabs can also be opened in a separate window. To do this, use the “New Browser Window” from 
the “Web” menu: 

This browser window will “float” on top of Pedigree Forge, and can have tabs of its own:



If you have a larger computer screen, you can also open more browser tabs and show them next to the 
content panels. To do this click on the “split” icon button on the right-hand side of the main Pedigree Forge 
window:

You can adjust the width of each side using the grip bar between. Clicking the “split” icon button again will 
hide the right-hand side panel. 

Bookmarks
You can customise the bookmark short-cut buttons that appear in each browser tab. To add a bookmark, 
navigate to the page you wish to be a book mark, then click on the “bookmark” icon, which is to the right of 
the address bar:

You will be prompted to add a name for the bookmark:

When you click “OK”, the bookmark will be added:

It will also be added to any new browser tabs created, but won’t be added to other tabs already open.

Bookmarks can be removed on the “Internet” tab of the “Options” dialog, accessed from “Options” on the 
“Tools” menu:



Select the bookmark you wish to remove from the “Bookmarks” list, then click on the Trash button. After 
being prompted to confirm, any new tabs created will not have that bookmark (it won’t be removed from 
currently opened bookmarks). 

There are a few places within text fields and in the browser itself, that using a right-click context menu, gives
you the ability to search the web for some text. The search engine to use can also be configured in the 
options dialog, as above.

If you need to empty the browser’s cache, for example clear all cookies, and auto-completion fields, this can
be done from the “more options” button on the browser tabs:



Web searches
Pedigree Forge allows you to make searches on certain websites, directly from the active person you are 
working with (you are likely to need your own subscription to access the data on these sites). These are 
accessed from the “Web” menu. 

The example selection shown above will try and find the current person on www.ancestry.co.uk, in their 
England and Wales probate collection. 

Note: the Smart Searches should be considered a first-step. They will sometimes do a very good result, for 
example, searching for Charles Robert Darwin’s will in the above entry finds it straight away. At other times, 
you may need to adjust the search parameters on the website. At the very least, the Smart Searches should 
save you from re-typing the information again. 

For ladies, most searches are initially made under their maiden surname (deaths/burials and probates 
searches are conducted using their last known married surname). You can check the “Use married name?” 
option from the relevant Smart Search screen to search under the married name:

If they appear in more than one family as a spouse, it will be the married name of the currently active 
spouse. 

The number and options for Smart Web searches are likely to be added to in future versions. 

http://www.ancestry.co.uk/


Web browser tricks
Having a web browser built in to Pedigree Forge means that it can sometimes use contextual information to 
help improve the experience of researching. Below are a couple of areas related to particular websites:

FindMyPast UK census call numbers:
When creating a census from www.findmypast.co.uk, Pedigree Forge can import and format the call 
number. Highlight the reference information shown with the transcript with the mouse, then right-click with
the mouse to show the context menu, and select “Add Source Call Number”:

The first part of the source title, archive, call number, accessed via, template, fact type and date will all then
be populated automatically:

If any fields that had already been added, they will be left unchanged. 

Ancestry UK census call numbers
When creating a census from www.ancestry.co.uk, Pedigree Forge can import and format the call number. 
Highlight the reference information shown with the transcript with the mouse, then right-click with the 
mouse to show the context menu, and select “Add Source Call Number”:

http://www.ancestry.co.uk/
http://www.findmypast.co.uk/


The first part of the source title, archive, call number, accessed via, template, fact type and date will all then
be populated automatically:

If any fields that had already been added, they will be left unchanged. 

Adding GRO references
The integrated web browser can be used to add GRO references directly from the General Register Office’s 
website, www.gro.gov.uk. Use the GRO’s site to locate references as required, for example, search for 
children by surname and mother’s maiden name. When you have found a birth or death reference, you can 
highlight the entry, then right-click with the mouse to show a context menu:

http://www.gro.gov.uk/


The fact will then be created (if it doesn’t exist) and a local citation added:

Make sure that the correct person is the one being edited, as this will be applied to the currently selected 
person.

Note: this option will also change the date if it is slightly off, for example, if we had Charles Waring Darwin’s 
birth as “About 1857”, perhaps based on an age on a census, it will be amended to “D1856”, which Pedigree 
Forge recognises as a GRO quarter date—see section on dates.

The option “Create Child from GRO Birth” can also be used. For this option, make sure that the child’s 
parents are currently selected as the active person and spouse. The child will then be created, and their 
approximate date of birth, and citation to the GRO reference, will also be populated.



To do lists
Pedigree forge allows you to have a basic “to do” list within each project. This is accessed from the check list
icon on the action bar that is located on the left-side of the Pedigree Forge main window:

The to do list panel has a table at the top, which includes all the “to do” items. The small buttons in the top-
right corner allow you to add, delete and re-order tasks:

Clicking on an item will allow you to edit the task’s description. It can be marked as complete with the check
box below:

The task will then show as complete: 

You can also right-click on the to do list to add/delete items. 



Project and user configuration
Pedigree Forge allows configurations for a particular project, for example, adding recognised places and 
tags. These are available on the “Project Settings” panel, which is accessed from the “Cog” icon, in the 
bottom left-hand corner of the Pedigree Forge main window:

Any changes made on this panel apply to this project only.

User preferences apply to all projects you open on your computer. These are set on the “Options Dialog”, 
accessed via the “Options” item on the “Tools” menu:

Some of these configuration options have already been covered in particular sections of this user guide.



Document vs database mode
Pedigree Forge can run in one of two modes. The default is “Document” mode. You can switch between 
modes on the “Options Dialog” accessed from the “Options” item on the “Tools” menu. Note: you have to 
close and reopen Pedigree Forge for the change in mode to take effect. 

It is recommended that you only work in one mode or the other; switching modes will cause confusion—
pick one. 

Document mode
In document mode (the default), Pedigree Forge works like most office type programs: you open a particular
file, you can edit the data and then must save it for the changes to take effect. If you don’t save the changes,
they will be lost.

This allows you to “fiddle” with a file, with the knowledge that you won’t change the main data unless you 
save it.

As with other applications like this, on closing a document that has changed, you will be prompted to ask if 
you want to save any changes. 

In document mode, the file you are working is saved in the background, in case Pedigree Forge closes 
unexpectedly, either due to a crash or system shut down—you will be prompted for which version you want
to keep when Pedigree Forge starts next time.

If you have a very large file, consisting of hundreds of thousands of people, you might notice a slight delay 
of a second or two, as the auto save background feature runs. 

In document mode, you can have multiple copies of Pedigree Forge open on your computer at the same 
time—you could even open the same file in each, but that would cause data loss, with the last one to save 
winning. 

“Document” mode files have the file extension “.ped” and are a flat text file (an extended GEDCOM format).

Database mode
Database mode works with an SQL database—any changes you make to your data are immediately written 
back to the database, so it is always up to date. There is no need to save your data, as this automatically 
happens in the background. You can still use the “Undo” option from the “Edit” menu to undo the last 
action, but beyond that, you can’t revert to earlier versions. 

As the data is written back to the database immediately, and controlled by an SQL database, no data is lost 
if Pedigree Forge shut down unexpectedly. This also means that there is no background auto saving of files 
and so there will no pause, even with very large files. 

“Database” mode files have the file extension “.pedb” and are SQLlite database files. 

Database mode will only allow a single instance of Pedigree Forge to run on your computer at a time. Trying 
to open a second instance of the program will not work. 



The first time you open Pedigree Forge in database mode, you have to create or open an existing database. 
The “Welcome to Pedigree Forge” database dialog will help you to create or open a database:

“Create New Database” will allow you to pick the file name and location for your new database. 

“Open Existing Database” will show a list of recent databases (if any) and or allow you to select another 
database with the Open File Dialog.

When working with a database mode project, there are very few differences. The main one is that there is 
no “Save” option on the “File” menu and the other is that when you close the file, you won’t be asked if you
wish to save any changes, as this will have been done automatically for you.

Database vs document mode trouble shooting
It is recommended that you work either in document or database mode (see the sections above for the pros
and cons of each). As Pedigree Forge can only work in one mode at a time, you might get an error message 
if you try and open a file of the other kind. For example, if we are in database mode, but double click on a 
“.ped”—document mode file, the following error will appear:



Similarly if we are in document mode, and double click on a “.pedb”—database mode file, the following 
error will appear:

The solution is the same: switch to the other mode. Start Pedigree Forge manually (from the windows 
“start” menu, or by whatever means you open the program. Then selected “Options” from the “Tools” 
menu and check (or uncheck) the “Use database mode” check box as appropriate:

When you close and reopen Pedigree Forge, it will be in the other mode.



Spell checking and hyphenation
Pedigree Forge includes a built-in British English spell checker. It works very similar to a conventional spell 
checker, where misspelt words are underlined in red, with the addition that “ignored” words are still 
underlined, but in a magenta.

This is useful in genealogy, it isn’t uncommon when transcribing an old document for there to be spelling 
mistakes. This mistakes can be marked as “ignored”, to flag that they aren’t quite correct.

Spell checking is applied to text fields, i.e. where text is entered, as well as on any charts and reports.

In the following example, Pedigree Forge doesn’t recognise “Joshiah” or “Wedgewood” and so has 
underlined both in red, in the person panel (where the information is added and edited).

And on the chart we are working with: 

The spelling checks only show on the screen; if a chart or report is printed or exported, the spell check 
underlining doesn’t appear.

In the above example, we have spelt Joshiah wrongly. In the text-editing field, we can highlight the misspelt 
word and then right-click with the mouse to be presented with options. This includes some spelling 
suggestions:

Selecting “Josiah” will change the word to the correct spelling:



In regard to Wedgewood, the accepted spelling for this family appears to be Wedgwood, i.e. without an “e”.
We can use the spelling suggestion to correct that, as with Josiah. However, if we were transcribing an old 
document with the particular spelling of Wedgewood, we might want to retain the word, but mark it as 
ignored:

This spelling would then be underlined in magenta, to show that it is being ignored:

The spell checker dictionaries and ignored words are per project. Words that have been added or ignored 
can be viewed from the Project Settings panel (the cog icon in the lower-left corner of the Pedigree Forge 
main window). The “Spelling and hyphenation” section isn’t shown by default, so you will need to click on 
the button next to it to expand the view. 

Each word in the lists of added and ignored words must be on its own line. When you have added any 
words, the “Update” button will apply the changes to Pedigree Forge’s dictionary. If you remove words, this 
doesn’t take effect until next time you open Pedigree Forge.

On loading Pedigree Forge, any user dictionaries on your computer will be read-in too. These aren’t are 
shared between many common Windows programs, but not all.



Hyphenation
Pedigree Forge uses hyphenation when it needs to break a word across a line boundary—mostly to create 
similar length lines when justifying text. This most commonly occurs in reports, but certain style of charts 
allow hyphenation of words too.

Pedigree Forge has built-in rules for hyphenation, which will do a reasonable job on most occasions, but if 
you want to specify hyphenation opportunities for particular words, then you can do so. These should be 
added to the “Hy~phen~ation” text box, located on the Project Settings panel—see section on spelling to 
locate this.

Each word should be entered on a separate line, and the tilde character ~ should be used to indicate in 
where the word hyphens can be added if needed.

The “antiquarian” style chart is one where text is justified. In the example below, we can see that Pedigree 
Forge has hyphenated Wedgwood as Wedg-wood, to fit into the space available for justification:

This was automaticity applied but if it hadn’t been, we could have entered the hyphenation opportunity 
into the “Hy~phen~ation” text box as Wedg~wood.

As with spell checking, once the text has been entered, the “Update” button must be clicked to apply.



Contacts
Pedigree Forge allows you to include contacts. This is how “submitters” are handled if importing information
from a GEDCOM file. This feature is probably of limited use to most genealogists, but professionals might 
wish to store client contact information here, so it can be kept with the project.

The contact editing panel is accessed from the contact card icon button, located on the main action bar, 
which runs down the left-side of the Pedigree Forge main window:

The contact panel works in much the same way as the other panels in Pedigree Forge, with a list of contacts 
at the top, and buttons to add or remove the selected contact. Clicking on a contact in the list makes it the 
active contact, and the information can be edited in the fields below:



Media Gallery
The Media Gallery panel is useful for adding captions to photos, for use in reports. It is accessed from the 
“pictures” icon button, located on the action bar, which runs down the left-side of the main Pedigree Forge 
window:

The basic use is very similar to the other editing panels in Pedigree Forge, whereby a list of all the items 
appears at the top. Selecting an item from the lists makes it the item being edited (with the fields below) 
and the small buttons above the list of items allow adding/deleting of the photos. 

Any gallery items should be located in the same folder as your Pedigree Forge project (.ped) file. 

People can be linked to items in the gallery. You can do this either when editing the people themselves (on 
the people editing panel), via the “Media” section:



Alternatively, the person can be linked to media gallery item the other way around, i.e. by selecting an item 
in the list of gallery items, and then right-clicking on the item in the list and selecting “Link to person”.



Activate Pedigree Forge
To activate Pedigree Forge, you will need to purchase the software, which will give you an activation key.
This is done from the “Help” option of the main menu bar, by selecting “Register”:

This will show the register dialog: 

Use the “Buy Registration Key” to obtain your activation key. Once this has been emailed to you, again go
into  the  Register  dialog  where you can enter  the same email  used to  purchase  the software  and  the
activation key provided. Then click the “Register” button. If the key and email are correct, your software will
be activated. 

Note: You must enter the email and key EXACTLY (including correct upper/lower case) as given in the email
sent to you. It is recommended that you “copy” the key from the email and “paste” it into the Activation Key
box. 



Updating Pedigree Forge
Pedigree Forge can be installed in two different ways. The method recommended for most users is to use 
the “MSIX” installer. If this doesn’t mean anything to you, then you should use this method! 

In this mode, updates are completely handled by Windows in the background, and updates will be applied 
automatically, and probably without you even noticing.

You can tell if this applies, as the “Check for updates” option on the “Help” menu isn’t selectable (greyed 
out) and the “Check for updates” frequency on the “Options” dialog is set to “auto”:

The MSIX technology on Windows also means that updates only change small amounts of the setup at a 
time, it cleverly only downloads the parts that have actually changed, so updates are quick, and  download 
the minimal data necessary. These installed applications are safer on modern versions of windows, as they 
run in a containerised environment and uninstall cleanly. 

Executable installer
If you are a power user or don’t want Pedigree Forge to be updated automatically by Windows, then you 
should install via the setup installer (executable program). In this mode, Pedigree Forge (rather than 
Windows) has to manage the updates. You can tell if this applies to your copy because the “Check for 
updates” option is available from the “Help” menu and you have the ability to set how often Pedigree Forge 
checks for updates, or even never if you wish, from the “Options” dialog, accessed from the “tools” menu:

Important: No technical support will be given for users who choose the executable installer. You will have to
navigate the security warnings, and virus scan settings yourself. 



Importing and exporting data from other applications
Pedigree Forge is one of many genealogy computer programs. To share and transfer information between 
them, the common format is known as GEDCOM, which is an acronym for GEnealogical Data 
COMmuncation. It was developed by the Family History Department of the Mormon Church. These file have
the extension “.ged”. 

The GEDCOM format has developed over the years; the most commonly used version is 5.5.1, which dates 
from 1999, although version 7 (also known as FamilySearch GEDCOM1)was introduced in 2021, the use of 
which is growing, but not all programs currently support this version. 

Important: GEDCOM is the best (but imperfect) tool we have to transfer data between applications. As each
program supports different functionality—part of what makes them unique—there is very likely to be some 
data lost each time you transfer information between different   applications  , as one program won’t have the
same features as another. For example, Pedigree Forge allows you to mark text as bold, and italics etc2. This 
isn’t supported by GEDCOM 5.5.1 at all, and many other programs don’t support this feature either, so the 
bold and italic attributes, are likely to be lost on transfer, although the text within should be retained. All 
good genealogical applications will support the “core” of GEDCOM, so things like names, dates, places, 
relationships, sources etc., should be transferred without issue. 

Note: Raw GEDCOM does not transfer any linked files (like photos). You will have to transfer these manually.

Importing fom GEDCOM
To import a GEDCOM file, select “File” from the main menu bar then “Import from GEDCOM”:

A file selection dialog will then be shown to allow you to locate and find the GEDCOM (.ged) file on your 
computer. Select the file and then select “Open”.

The file should then be imported into Pedigree Forge.

1 FamilySearch GEDCOM is a trademark of Intellectual Reserve, Inc. All rights reserved. A service provided by The 
Church of Jesus Christ of Latter-day Saints https://gedcom.io/

2 GEDCOM version 7, introduced a limited amount of support for rich text.

https://gedcom.io/


After the import, the following dialog box will appear: 

Selecting “Yes”, will open your system’s text file view and show any issues noted when importing the file—
reviewing these will help to minimise any loss of fidelity in data. Select “No” to start using the program in 
Pedigree Forge.

Important: After the file has been imported, you will need to save it—use the usual Save or Save As files to 
select where you want to save the imported file. 

Exporting to GEDCOM
To export a Pedigree Forge file to GEDCOM, select “File” then “Export to GEDCOM” from the main menu 
bar:

You will then be asked to confirm how you wish to export the file: 

As at the time of writing (2025), most other programs support GEDCOM 5.5.1, and so is probably the best 
choice. However, GEDCOM 7, does offer more options, which can be useful—for example, the ability to 
have rich text transfer—and so might be better if you know that the program you are exporting to supports 
version 7. In reality, you might want to export as both (selecting different file names for the output), and 
experiment with the importing program.

Version 7 also introduces the ability to export a zip file, which includes an other files linked—raw GEDCOM 
only transfers the data, not any linked files.



Expert Information
The information given above will be enough for most users, and so many people will want to skip the next 
section. This section is for expert users who need to know more about how Pedigree Forge handles certain 
GEDCOM features on import and export. 

Pedigree Forge Features and Data Model
Pedigree Forge works internally with Unicode (UTF-8), so should have no trouble with importing 
information in Unicode, although display of Unicode characters requires suitable fonts.

Except in a few defined places, Pedigree Forge only supports left-to-right scripts, i.e. text that runs from left 
to right. Right-to-left scripts, and bidirectional text isn’t supported, although it will work in some scenarios. 

Pedigree Forge supports record structures very similar to those in GEDCOM, namely: 

INDI (Individual), FAM (Family), SOUR (Source), OBJE (Object/media), REPO (Repository/archive), NOTE—
SNOTE in v7 (Notes), SUBM (Submitters).

Pedigree Forge supports a superset of GEDCOM date and age formats. 

Pedigree Forge supports a HTML like markup language for text, which is a superset of that in GEDCOM 7.

Other items in Pedigree Forge are all extensions over GEDCOM, for example: charts, reports, transcripts. 

Record identifiers created by Pedigree Forge only consist of numeric digits (0-9), alphabetical characters (A-Z
or a-z) and the underscore _.

GEDCOM to Pedigree Forge
GEDCOM is a very flexible data exchange format. The “core” functionality will work when importing to 
Pedigree Forge, and there should be only limited data loss, as long as the file being imported does conform 
to the GEDCOM specification it claims to be. 

Character Sets
Pedigree Forge will safely import the following character sets:

• Unicode UTF-8 (with or without byte order mark). If the Byte order mark is present, this will take 
precedence. The HEAD.GEDC.CHAR should be set to “UTF-8”

• Unicode UTF-16 (either endian), but only with accompanying Byte Order Mark. Without the Byte 
Order Mark, the endianness isn’t known. The HEAD.GEDC.CHAR should be set to “UNICODE”. The 
file is converted to UTF-8 before parsing begins. 

• “ASCII”. Ascii is a 7-bit character set, and a subset of UTF-8 and also many windows codepages. If a 
GEDCOM file states that it is ASCII in the  HEAD.GEDC.CHAR, then it will be treated as Ascii, with any
characters over 127 (i.e. using 8 bits), treated as windows code page 1252, which is also a superset 
of ISO 8859-1. This is the same convention used in parsing HTML 5.

• “ANSEL. Ansel was the original character set for GEDCOM files, but is long since obsolete. Its is 
compatible with ASCII up to character 127, but then follows its own encoding, with combining 



diacritics, rather than composed characters. Pedigree Forge will try to read in ANSEL files, and 
convert common sets of diacritics and letters to their composed Unicode form. As ANSEL is 
obsolete, this feature isn’t well tested. 

• “ANSI”. Whilst not officially supported by GEDCOM, many programs output their data using a “Code 
Page”. Pedigree Forge will treat ANSI as windows code page 1252.

Low-level features of GEDCOM
Version 5.5.1 GEDCOM identifiers can be virtually any character. In practice (and required in version 7), they 
must only be alpha-numeric values (0-9, A-Z or a-z) or the underscore character (_). Pedigree Forge imposes
the stricter version 7 behaviour when importing GEDCOM files, and never creates its own identifiers with 
other characters.

When importing a GEDCOM file that has characters other than 0-9, A-Z, a-z or _, they are mapped to new 
record identifiers. 

Structures of the lineage-linked form
The following structures of the GEDCOM “lineage-linked form” have no direct mapping to Pedigree Forge, 
and so describe the action that is taken on importing:

Submission (SUBN) records

Submission records were/are used internally by FamilySearch, for submission of files. They are imported 
into Pedigree Forge, as are any information they contain. They will be written back out on export too, but 
there is no facility within Pedigree Forge to modify them. Note: The optional link from the HEAD to a SUBN 
record is ignored. 

Latter Day Saints Specific Ordinances and Spouse Sealings

These are included on INDI and FAM records as appropriate. They are specific to FamilySearch, and are not 
imported into Pedigree Forge. The are skipped and a warning is issued. 

Links from INDI and FAM records to submitters. 

GEDCOM allows linking from INDI and FAM records to submitters. These are silently ignored by Pedigree 
Forge. 

Restriction Notice

GEDCOM allows restriction notices to be placed on INDI and FAM records. These are imported, can be 
edited within Pedigree Forge, and are exported again, but aren’t currently used for any purpose within 
Pedigree Forge. 

Various Specific ID numbers

GEDCOM allows various (and numerous) kinds of identifiers to be placed on various record kinds. 

TO DO: Import, modification, and export of REFN (at least 1) for a user reference number and round-trip of 
a RIN.



Alias (ALIA) and Association (ASSO) links on Individual Records

GEDCOM allows linking individual records via an ALIA and ASSO mechanism. 
Pedigree Forge supports both. Some applications use the ALIA mechanism in a 
way not specified in the GEDCOM spec; Pedigree Forge only supports the 
method specified in the GEDCOM specification, i.e. linking to another record that
might be an alias for the person. 

TO DO: Review the various kinds of enums for ASSO

Names

The GEDCOM specification allows an unbounded number of NAME structures for a person. Pedigree Forge 
currently only uses the first two of these; the first being the preferred, and the second being an alias. 
Additional NAME structures are imported and exported again, but they aren’t used in Pedigree Forge, and 
there is no way to edit or delete them in Pedigree Forge either. Also see the “Aka” tag.

TO DO: More names.

Aka (Also Known As) tag

Some applications use an extension tag: _AKA to indicate an alias name. Pedigree Forge imports these (if 
present) as the non-preferred name. 

Note links 

GEDCOM allows various places in which notes can be added. It also allows an unbounded number of notes 
in those places too, either directly placed there or linked to a note record. This makes user interface very 
messy. Pedigree Forge allows notes in more limited places, and these are generally not linkable to a note 
record. 

TO DO: Reading all the places that GEDCOM allows many notes; Perhaps place 
them all in their containing record? Also, changing notes from links to inline 
(unless the record “bins” for these notes might allow linking?)

Media objects and links to media objects

GEDCOM allows zero or many links to media objects (and embedded objects in version 5.5.1), in many 
locations: for example, on an individual; on facts for the individual, on any where that citations are allowed 
for the individual (in the person record itself, in the name structure, in any facts). This is impossible to 
support in the Pedigree Forge user interface, as it would make usability impossible. 

Pedigree Forge supports embedded objects, and object links, in more limited places. Where these are 
allowed in the GEDCOM specification, but not in Pedigree Forge, the links are placed in the owning record. 
For example, a media link from a birth fact, would be placed in the person record.

TO DO: Reading all the places that GEDCOM allows media links and making 
sure that they are “lifted” into the owning record.



Citations to sources

TO DO: Support more places where the GEDCOM spec allows citations to 
sources, e.g: PERSONAL_NAME_STRUCTURE, ASSOCIATION_STRUCTURE 
others? On (S)NOTE record

Multiple families as a child
GEDCOM allows a person to appear in an unlimited number of families as a child; Pedigree Forge only 
supports two families in which a person can appear as a child.

Multiple families linked to same spouse
There are occasions when two individuals might be joined more than once, for example, perhaps they 
married, divorced, then remarried. There are two ways that this could be implemented: either through 
having a single family record, but multiple marriage events, or having multiple family records, each with a 
marriage. The GEDCOM specification supports either.

For consistency, Pedigree Forge merges situations where the same two people are linked as spouses via 
multiple family records, into a single family record, and allows multiple marriages. The alternative (keeping 
multiple family records) might give the impression that some kind of order of spouses can be maintained, 
but this isn’t useful in practice—you wouldn’t draw the same spouse twice on a family chart, even if this 
were the case, nor would you introduce them twice in a report. 

Multiple families in a single object record
GEDCOM supports the ability to have multiple files linked to the same object, although this 
feature isn’t supported well in other applications. When importing an object record that contains 
multiple files, the additional files are split out into new object records. 

Calendar Escapes
GEDCOM dates support various calendar escapes, some of which were never implemented. The 
@#DROMAN@ escape was declared in version 5.5.1, but never defined. Any dates containing this 
will be considered invalid in Pedigree Forge. The @#DUNKNOWN@ calendar escape was also 
defined in 5.5.1, and isn’t implemented in Pedigree Forge. The other calendar escapes are 
implemented. 

INT Dates

GEDCOM 5.5.1 (but not 7), allows dates with an INT prefix. This mechanism was designed to allow 
specifying that a date was based on interpretation of some other text. These dates are considered invalid in 
Pedigree Forge. The information is read in and retained, but Pedigree Forge doesn’t know how to interpret 
them. 

TO DO: Is it worth implementing this? 



Other Items

TO DO: Fixing file locations on import

TODO Gedcom 7 @VOID@ record on INDI.CHIL… need to consider how to 
implement this?? Do we have null checks in enough places? 

GEDCOM “Y” on facts

TO DO: Import the “Y” on a fact/event, like DEAT Y to indicate that it 
happened.

GEDCOM Extensions – Name parts in speech marks

TO DO: Import name parts in speech marks as name used

GEDZIP

TO DO: Implement GEDZIP properly

GEDCOM 7 Sort dates

TO DO: Implement sort dates

GEDCOM 7 “No” events

TO DO: Implement no events

GEDCOM 7 Phrases

TO DO: Better implementation of GEDCOM 7 phrases

GEDCOM 7 Objects Crop Etc.

TO DO: Better implementation of GEDCOM 7 object meta data, like cropping

GEDCOM 7 Exid

TO DO: Better implementation of GEDCOM 7 exids

Pedigree Forge to GEDCOM
The following is how Pedigree Forge will treat information that has no representation in GEDCOM files, and 
so can’t be exported, or has to be exported in a different way.

Inline media objects.
GEDCOM 5.5.1 allows media objects to be defined both “inline”, i.e. within other records, or as links to 
object records. The actual file data is always in external files, rather than inside the GEDCOM itself. Version 
7 only allows links to object records. 



Dual dating

GEDCOM version 7 does not support dual dates. Dates exported to version 7 use the “modern-style” year, 
and export a date phrase.

Date Extensions

Pedigree Forge supports various extensions to the GEDCOM data format, for example, GRO quarters. These 
are exported as valid GEDCOM dates, that are closest to Pedigree Forges interpretation. See the section on 
dates for more information. 

Rich text
Pedigree Forge permits rich text, like bold, italic, heading and tables, to be used. Version 7 supports a 
limited amount of markup. Any rich text features are exported as plain text, so for example, the bold 
attribute will be lost and text in a table be retained, but without the table.

TO DO: Add option to export?

Transcription Forms

Pedigree Forge permits pre-defined transcript forms for things like birth certificates and censuses. There is 
no corresponding way for this information to be transferred in GEDCOM, and so the information will be lost.

TO DO: Add option to export as text?

Charts and Report

Pedigree Forge creates charts and reports. There is no mechanism for these to be transferred in GEDCOM. 
Whilst the genealogical information will be transferred, the chart layouts and report configuration isn’t 
exported to GEDCOM—other applications would not know what to do with it.



Other features
Pedigree Forge contains a number of other advanced features. Their use should be fairly intuitive, but this 
section will be expanded in the future.

Scripting System
Pedigree Forge has a built-in scripting system, which uses the programming language Lua. Whilst the 
“plumbing” is in place for this feature, there is more to do before it is ready for use. 

The planned use of this feature is to allow it to extend the functionally of “Smart” Web Searches, Audit 
checks, Queries, Reports and Charts, i.e. add-ons will enable further customisation of those features. 
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